## Contents

**Welcome to Reflection X Advantage**  
Features 8  
Operating Modes: Domain vs. Standalone 9

**Installation and Migration** 11  
System Requirements 11  
Install Reflection X Advantage 12  
Which Features Should I install? 14  
Setup Program Features (Windows) 15  
Selecting Features and Languages 15  
Installer Advanced Tab 16  
Upgrade and Migration 17  
Upgrading from Reflection X Advantage 2.x 17  
Migrating Legacy Reflection X Settings 17  
Feature Guide for Migrating from Legacy Reflection X Products 18  
Migrating Settings From Hummingbird Exceed 21  
Uninstall Reflection X Advantage 22  
Remove All Reflection X Files 23

**Getting Connected** 25  
Use XDMCP to access your host desktop 25  
Run an X Client Application on your Windows Desktop 26

**Getting Started with Reflection X Domains** 31  
Domain Setup: Improve Performance Over a Slow Network 31  
Domain Setup: Leave a Session and Rejoin from a Different Computer 35  
Domain Setup: Centralize Session Configuration 39  
Configure and Test User Authentication 44
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reflection X Advantage Basics</strong></td>
<td>47</td>
</tr>
<tr>
<td>The X Manager Interface</td>
<td>47</td>
</tr>
<tr>
<td>Reflection X Icons</td>
<td>49</td>
</tr>
<tr>
<td>Understanding Session Definitions</td>
<td>51</td>
</tr>
<tr>
<td>Frequently Asked Questions</td>
<td>51</td>
</tr>
<tr>
<td>Reflection X Advantage Database Files</td>
<td>52</td>
</tr>
<tr>
<td><strong>Planning a Reflection X Domain</strong></td>
<td>55</td>
</tr>
<tr>
<td>Reflection X Domain Components</td>
<td>55</td>
</tr>
<tr>
<td>Reflection X Session Components</td>
<td>57</td>
</tr>
<tr>
<td>Data Flow for a Basic Session</td>
<td>58</td>
</tr>
<tr>
<td>Data Flow for a Distributed Session</td>
<td>59</td>
</tr>
<tr>
<td>Determining the Domain Components to Install</td>
<td>62</td>
</tr>
<tr>
<td>Best Practices for Designing a Reflection X Domain</td>
<td>62</td>
</tr>
<tr>
<td>Configure Reflection X Domain Nodes</td>
<td>64</td>
</tr>
<tr>
<td>Set Up Domain Authentication</td>
<td>65</td>
</tr>
<tr>
<td>How Domain Access is Controlled</td>
<td>66</td>
</tr>
<tr>
<td>Set Up LDAP Authentication</td>
<td>66</td>
</tr>
<tr>
<td>Set Up Reflection X Internal Authentication</td>
<td>67</td>
</tr>
<tr>
<td>Add or Remove Domain Users</td>
<td>68</td>
</tr>
<tr>
<td>Unlock a Domain</td>
<td>69</td>
</tr>
<tr>
<td>Deploy with Java Web Start</td>
<td>70</td>
</tr>
<tr>
<td><strong>Deploying to Windows Workstations</strong></td>
<td>73</td>
</tr>
<tr>
<td>Performing a Basic Deployment</td>
<td>74</td>
</tr>
<tr>
<td>Performing an Advanced Deployment</td>
<td>74</td>
</tr>
<tr>
<td>Create an Administrative Installation Point</td>
<td>75</td>
</tr>
<tr>
<td>Attachmate Customization Tool</td>
<td>76</td>
</tr>
<tr>
<td>Open the Attachmate Customization Tool</td>
<td>76</td>
</tr>
<tr>
<td>Set up a shortcut to ACT</td>
<td>77</td>
</tr>
<tr>
<td>Select a Customization Type</td>
<td>78</td>
</tr>
</tbody>
</table>
Reflection X Advantage is an X server that installs on one or more PCs or UNIX computers, and allows you to work with X client applications on X Window hosts.

As with earlier versions of Reflection X, you can install Reflection X Advantage on a single computer and use X Manager to customize a variety of X server settings and start X sessions. Starting with Reflection X Advantage, you can also use X Manager to join or leave running X sessions as well as share sessions among users, across computers, and across platforms. You can monitor the status of running sessions either from the X Manager or from a new tool for administrators called the Administrative Console.

Using Reflection X Advantage, you can address problems with low bandwidth or high latency connections with compression and optimization features, and obtain extra insurance against losing sessions (for example, as a result of a power outage) using the Domain Services options that are available when you run in domain mode.

Reflection X Advantage consists of three applications. Depending on the feature set that was installed on your computer, one or more of these applications will be available from the Start menu:

- **X Manager**: Access X hosts and clients, configure and share sessions, and monitor session status. Typically, in a single-user environment, the basic, standalone X Manager application is installed. If you want to use Reflection X Advantage as a traditional PC X server, this is the only application you'll need.

- **X Manager for Domains**: Participate in a centrally administered domain that provides pre-configured public definitions used to access X hosts and clients. As an authorized domain user, you can start, join, leave, and share a running X session. You can use all public definitions created by administrators, as well as create private definitions available only to you. If your enterprise installed Reflection X as a distributed application to maintain centralized control over access to X hosts and clients, you will likely have X Manager for Domains installed.

- **Administrative Console**: Configure and manage Reflection X domains, control domain authentication, and handle load balancing, optimizing performance for a group of X servers. As an authorized domain administrator, you may have both X Manager for Domains and the Administrative Console installed on your computer.
Features

In addition to traditional X server functionality, Reflection X Advantage offers many next-generation X server capabilities:

- **Session sharing and joining**
  
  With Reflection X Advantage's patent-pending technology, you can share your sessions with other users, thus allowing them to see your X desktop and applications. You can also join sessions that other users have made available for sharing. You can even configure a session so that another user can take control of it.

- **Session persistence and backup**
  
  With Reflection X Advantage, you can suspend, or "leave" your session with an X client instead of terminating it. When you rejoin your session, either at work or from home, your X client application is immediately available. As a supplement to this feature, Reflection also provides session persistence. When you enable the **Network fault tolerance** option, your session is held in memory on network servers and remains immediately available — even if your workstation loses power.

- **Improved performance over slow network connections**
  
  If you're connecting over a low bandwidth or high latency connection, you can use Reflection X Advantage domain services to improve performance. The Reflection X technology optimizes performance by caching and compressing X protocol, and by eliminating redundant round-trips for certain types of X protocol.

- **Centralized session configuration**
  
  Reflection X domain features can help simplify session setup for end users. Administrators can create and maintain sessions in a single centralized location and provide users with access to these sessions. Users can get started quickly using these centrally configured sessions, and can also create and configure individual sessions on their own workstations.
• **Load balancing**

   Load balancing is one of the benefits of running distributed sessions. In a distributed session environment, Reflection X Advantage has been installed on more than one computer, thus creating multiple domain nodes. When a user initiates a session, the session is run on the least-loaded domain node.

• **Negative coordinate support**

   Client applications with dimensions that extend into negative display coordinates can now be fully displayed instead of being truncated.

• **X11 extension support**

   Reflection X provides support for X11 extensions including Render, Damage, and XFixes.

• **Native IME support**

   Native IME support lets you use your workstation's input method editor (IME) to compose characters (including Japanese, Korean, and Chinese). The XIM server provided by Reflection X obtains the composed text from your IME and passes it to XIM-aware clients. This means that you can work with varied X clients without having to learn new input techniques.

• **X.509 certificate authentication**

   Secure Shell connections require both user and host authentication. In addition to supporting standard options for user authentication (passwords and public keys), Reflection X also supports authentication using X.509 certificates. Certificates can be stored in the Reflection X Advantage Store, the Windows Certificate Store, or on a Smart card or similar device. Also, by downloading and installing Reflection PKI Services Manager (a free utility that provides certificate validation services), you can configure Reflection X to authenticate hosts that present X.509 certificates.

**Operating Modes: Domain vs. Standalone**

Reflection X can be operated in either "Standalone" or "Domain" mode.

**Standalone mode**

Operating Reflection X in Standalone mode is similar to using its predecessor, Reflection X 14.0. You use one application, X Manager, and do not have to set up a Reflection X domain. You use the basic X Manager to access X hosts and clients, configure and share sessions, and monitor session status — all from your own desktop.
Domain mode

Using Reflection X in Domain mode gives you access to distributed domain services that support centralized administration of X session definitions, session persistence and backup, and control over authentication services for users participating in the domain. To use these features, an administrator must install Reflection X on two or more computers, and set up a domain.

To log on and participate in a domain, you use the Domain mode applications, X Manager for Domains and the Administrative Console.

Domain administrators run the Administrative Console to configure and manage Reflection X domains, and handle load balancing, optimizing performance for a group of X servers. Only members of the Administrator group have permission to run the Administrative Console.

Domain users run X Manager for Domains to log onto a domain that provides pre-configured public definitions used to access X hosts and clients. As an authorized domain user, you can start, join, leave, and share a running X session. You can use all public definitions created by administrators, as well as create private definitions available only to you.


\section*{System Requirements}

Specific requirements for Reflection X Advantage vary based on other hardware and software components present.

\textbf{Operating system and platform support}

- Windows 7 32-bit and 64-bit
- Windows Vista SP2 32-bit and 64-bit
- Windows XP SP3 32-bit and 64-bit
- Windows Server 2008 32-bit and 64-bit
- Windows Server 2008 R2 64-bit
- Windows Server 2003 32-bit and 64-bit
- Linux 32-bit and 64-bit
- Solaris 32-bit and 64-bit
- Solaris Sparc 32-bit and 64-bit
- HP-UX PA-RISC 32-bit and 64-bit
- HP-UX Itanium 64-bit
- Mac OS X 64-bit
- Citrix Presentation Server/XenApp (for multi-user environments)
- VMware
Processor

1 GHz, 32-bit or 64-bit (1.5 GHz or higher dual-core, 32-bit or 64-bit recommended)

System memory (RAM)

Windows 7, Windows Vista, Mac OS X, and HP-UX
1 GB (2 GB recommended)

All other operating systems, including: Windows XP, Linux, and Solaris
768 MB (2 GB recommended)

Notes:

- The computer requirements for Reflection X domain controllers and domain nodes depend on the number and types of sessions running on the domain and how the sessions are configured.

- An Internet browser is required to view the application Help. JavaScript must be enabled to use navigation, search, and other Help features. Supported browsers include IE 6 or later, Firefox 2 or later, and Google Chrome.

- Technical note 2505 (http://support.attachmate.com/techdocs/2505.html) discusses security issues related to Reflection X Advantage security features. If you use these features, you should consult this technical note on a regular basis for any updated information regarding these features.

- In preparing system requirements guidelines, Attachmate may rely on published claims (that it cannot independently confirm) regarding the capabilities of the non-Attachmate products. Attachmate therefore recommends that you contact your suppliers directly with questions or concerns regarding their products.

Install Reflection X Advantage

To install on Windows

1 Log on using a Windows account with administrator privileges.

2 From the download site, click the Windows download link and run the download program.

3 Select a location for the installer files, and then click Next. This extracts the files to the specified location and starts the Attachmate Setup.
4 To view and/or modify which features are installed, click the Feature Selection tab. X Manager is installed by default. For a summary of additional Reflection X Advantage features that you can install to run Reflection X in domain mode, see Which Features Should I Install? (page 14)

Notes:

- If you are installing Reflection X 2011 or Reflection Suite for X 2011, Reflection X Advantage is included in the same installer with other available applications.

- For additional information about using the installer see Attachmate Setup Features (page 15).

- For information about viewing the install log, see Installer Advanced Tab (page 16).

- An Administrative installation doesn't install the product to your workstation. It copies files to an administrative installation point. This network location can be used by deployment tools to access and create packages that are deployed to workstations. End users can perform workstation installations by running setup.exe from this location. For additional information about customizing and deploying a Windows installation, see Advanced Installation Topics (Windows) (page 73).

---

To install on UNIX

1 Download the installation package for your platform from the download site.

2 Unzip the download file; for example:

```
unzip -d rx-advantage-3.0.999-prod-linux.zip
```

The expanded package contains binary files for installing on different platforms. Locate the appropriate file for your UNIX platform.

Note: For additional information about using zip utilities to expand .zip UNIX packages, refer to Technical Note 1925 (http://support.attachmate.com/techdocs/1925.html).

3 If you unzipped on a Windows computer, copy the installation package file for your platform to your UNIX computer.

4 Log on as root and navigate to the directory that contains the installation package file.

5 Change the permissions of the installation package to give execute permissions to the file owner. For example

```
chmod 744 rxa-3.0.999-prod-i586-linux.bin
```
6 Start the installation program. For example:

```
./rxa-3.0.999-prod-i586-linux.bin
```

Note: The command above launches the InstallAnywhere installation program which requires an X11 Windows display. To initiate a command line installation, you can add the parameters `-i console`. For example:

```
./rxa-3.0.999-prod-i586-linux.bin -i console
```

7 You can modify the feature selections during the install. X Manager is installed by default. For a summary of additional features that you can install to run Reflection X in domain mode, see *Which Features Should I Install?* (page 14)

Note: On UNIX systems, an install log is created here:

```
/opt/rxadvantage/Attachmate_Reflection_X_Advantage_InstallLog.log
```

---

**To install on a Mac**

1 Download the installation file (*.dmg) to your Mac.

2 Double-click the installation file.

   This opens a Finder window that contains an installer metapackage file (*.mpkg) and a documentation folder.

3 Double-click the metapackage file to start the installation.

4 To view and/or modify which features are installed, from the **Installation Type** step, click the **Customize** button. X Manager is installed by default. For a summary of additional features that you can install to run Reflection X in domain mode, see *Which Features Should I Install?* (page 14)

Note: On the Mac, an install log is created here: `/var/log/install.log`.

---

**Which Features Should I install?**

X Manager (standalone) is installed by default. If you plan on configuring a Reflection X domain, you need to install additional features. The following table summarizes some typical installation configurations. For details about how each domain feature works, see *Planning a Reflection X Domain* (page 55).

Note: You can install and use any combination of Reflection X Advantage features on a single computer. The following table provides guidelines, but you are not limited to these configurations. For example, you may want to install and run both X Manager (standalone) and X Manager for Domains on the same computer.
To configure this  | Install these features
--- | ---
Standalone user workstation | ▪ X Manager
Domain user workstation | ▪ X Manager for Domains
Domain administrator | ▪ X Manager for Domains
 | ▪ Administrative Console
Domain controller | ▪ X Manager for Domains
 | ▪ Administrative Console
 | ▪ Reflection X Service (all features)
 | ▪ Run Domain Controller
 | ▪ Allow Sessions
Domain node | ▪ Reflection X Service
 | ▪ Allow Sessions

**Setup Program Features (Windows)**

The Attachmate Setup starts automatically after you extract the downloaded files onto your Windows computer, or when you double click the `setup.exe` program from a DVD or administrative installation point. Use the tabs to configure your Windows installation.

**Selecting Features and Languages**

Use the **Feature Selection** tab select how you want to install product features.

1. Click the **Feature Selection** tab.
2 For each item, select from the options below.

<table>
<thead>
<tr>
<th>Choose</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature will be installed on local hard drive</td>
<td>Install an item.</td>
</tr>
<tr>
<td>Feature will be installed when required</td>
<td>Advertise an item. For example, you can select a component from the Start menu, and it will install at that time.</td>
</tr>
<tr>
<td>Feature will be unavailable</td>
<td>Leave an item uninstalled. You will still be able to install the item later using the Windows Add/Remove Programs control panel.</td>
</tr>
</tbody>
</table>

**Installer Advanced Tab**

Getting there

1 Run the Attachmate Setup (setup.exe).

2 Click the **Advanced** tab.

The options are:

- **Install to this PC**
  
  Installs Reflection X to your computer.

- **Create an Administrative Install image on a server**

  Note: An administrative installation does not actually install the product — instead, it creates an installation image that you can use to deploy Reflection X to end users.

  When you create an administrative installation image, an image of Reflection X is copied to a network location for later installation to multiple workstations. This network location can be used by deployment tools to access and create packages that are deployed to workstations. Also, end users can perform installations by running setup.exe from this location.
Log file settings  By default an installation log file is created, but this file is deleted if the installation succeeds. (This configuration avoids accumulation of large log files after successful installations.) To save a log file for all installations, including successful ones, select Create a log file for this installation, and clear Delete log file if install succeeds.

The installation log file, which provides details about the installation, is saved in the user's temp directory (%tmp%) with a generated name that begins with atm. To open this folder, launch the Start menu Run command and enter %tmp%.

Upgrade and Migration

Upgrading from Reflection X Advantage 2.x

If you are upgrading from Reflection X Advantage 2.x, note the following:

- You can install version 3.0 over an existing copy of version 2.x. (Version 2.x is uninstalled as part of the installation process. Your database files remain in place.)

- Your 2.x database files are migrated automatically to the current version the first time Reflection X Advantage is started.

- If you run Reflection X Advantage in domain mode, you need to upgrade all computers in the domain at the same time.

Migrating Legacy Reflection X Settings

The first time that you start Reflection X Advantage (either X Manager or X Manager for Domains), local settings from legacy Reflection X products (v. 13 or 14) are migrated automatically and saved to a Reflection X definition file (*.rxd). (Your legacy Reflection X files are not changed). A prompt appears asking if you want to import the migrated settings.

Note: If you choose not to import the settings when you first start X Manager or X Manager for Domains, you can import the migrated settings at a later time. Using this option gives you an opportunity to explore the default configuration before you import your migrated settings.

Use the following procedure if you decide to wait and import settings at a later time:
To import migrated settings from a definition file:

1. From X Manager or X Manager for Domains, click **File > Import**.

2. Browse to your Windows user profile folder to locate the definition file that contains your migrated settings. The definition file name identifies the product and version whose settings were migrated. For example: Reflection X 14_0_7.rxd

   On Windows XP, the default location is: \Documents and Settings\<user>\.attachmate\rx\migration\n
   On Windows 7 and Windows Vista, the default location is: \Users\<user>\Documents\.attachmate\rx\migration\n
3. In the **Import Definitions** dialog box, select all the definitions.

4. Click **Import**.

**Using migrated settings**

Reflection X stores client settings in *.rcx files and stores X server settings in the Windows registry. Reflection X Advantage stores all settings in a database. When you import settings created by the migration utility, your settings are added to the database. The imported settings appear as new session, server, and/or client definitions. Because session definitions aren't used in Reflection X, it's a good idea to understand how to work with sessions before you use your imported settings. For information about differences between Reflection X (legacy) and Reflection X Advantage, and for help understanding your migrated settings, see [Technical Note 2390](http://support.attachmate.com/techdocs/2390.html).

---

**Note:** You can also migrate settings manually using the **rxmigrate** command line utility. This is useful if you have configured settings in a shared network location; these settings are not migrated automatically.

---

**Feature Guide for Migrating from Legacy Reflection X Products**

If you are upgrading from older Reflection X products (version 13 or 14), you'll find that the X Manager user interface in Reflection X Advantage includes many of the same capabilities, and certain features work differently than they previously did.

Use the following table to determine where features are located in the new X Manager provided with Reflection X Advantage.

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client file (.rcx)</td>
<td><em>Client definition</em> (page 101)</td>
</tr>
<tr>
<td>Name in Reflection X version 14.x</td>
<td>Name/location in Reflection X Advantage</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Client templates</td>
<td>The function formerly provided by individual client templates is handled by interactive fields in the <strong>Client Definition</strong> pane, and by public client definitions (page 104) created by the administrator.</td>
</tr>
</tbody>
</table>

**Client connection settings**

such as **Method, Host name, User name, Password, and Command**

**Advanced Client Connection Settings**

- Never close client starter connection
  - **Client Definition > Advanced button > Never close connection**
- Secure Shell options
  - **Client Definition > Advanced button > General, Encryption, and Authentication tabs**
- Secure Shell key management
  - **Tools > Secure Shell User Keys, Tools > Secure Shell Host Keys**
- Telnet options
  - **Client Definition > Advanced button > Port**

**XDMCP connection settings, such as Method and Host name**

- **Session Definition pane**

**X server instances (config)**

- **Server Definition pane**

**X server templates**

(for example, **XDMCP_Broadcast**)

- **Server Definition pane**

*Note: In Reflection X version 14.0, X server templates were provided to simplify configuring and opening pre-configured X server instances. These default templates are longer provided.*

**Display settings**

- **X display number**
  - **Session Definition > Advanced > Require display number** (typically, Reflection X Advantage dynamically allocates the display number based on available ports).

**X Screen settings**

- **Specify total number (of X screens)**
  - This setting has become an action. To add or remove an X screen, click the plus (+) or minus sign (−) in the title bar of the **Screen Definition** table (**Server Definition > Windowing**).
- **Virtual size (pixels) > Width**
  - **Server Definition > Windowing > Screen Definition table > Virtual Width (Pixels)**
<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual size (pixels) &gt; Height</td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Virtual Height (Pixels)</td>
</tr>
<tr>
<td>Dimensions (mm) &gt; Width</td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Width (mm)</td>
</tr>
<tr>
<td>Dimensions (mm) &gt; Height</td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Height (mm)</td>
</tr>
<tr>
<td>Place it on monitor(s)</td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Monitor</td>
</tr>
<tr>
<td>Full size (no title bar)</td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Hide title bar</td>
</tr>
</tbody>
</table>

**X Server settings**

- Backing store and Save unders
- Enable X11R3 bug compatibility
- Confirm close when clients are connected
- X Server extensions
- Log file

**Font settings**

- Font path
- Log font activity
- Allow font substitution
- Try font server on client host

**Color settings**

- Default visual type
Name in Reflection X version 14.x | Name/location in Reflection X Advantage
---|---
Colormap preallocation settings | Server Definition > Windowing > Screen Definition table > Black and White Pixels and Allocate B&W in Client Maps
Advertise linear visuals | Server Definition > Windowing > Screen Definition table > Linear Visuals
Advertise single depth visuals | Server Definition > Windowing > Screen Definition table > Single Depth Visuals

Security settings

> Host-based security | Session Definition > Network Security > Host-based authorization
User-based security | Session Definition > Network Security > User-based authorization
FIPS mode | From the Administrative Console:
  Domain Composition > FIPS mode

Network settings

> Disable remote TCP/IP connections | Session Definition > Network Security > Allow remote IP connections
Enable keep alives | Session Definition > Network Security > Perform IP keep alives
Log server network activity | Session Definition > Logging > Log network activity

Migrating Settings From Hummingbird Exceed

The first time that you start Reflection X Advantage (either X Manager or X Manager for Domains), local settings from Hummingbird Exceed products (versions 9.0 through 13.0) are migrated automatically and saved to a Reflection X definition file (*.rxd). (Your existing Hummingbird files are not changed). A prompt appears asking if you want to import the migrated settings.

Note: If you choose not to import the settings when you first start X Manager or X Manager for Domains, you can import the migrated settings at a later time. Using this option gives you an opportunity to explore the default configuration before you import your migrated settings.

Use the following procedure if you decide to wait and import settings at a later time:
To import migrated settings from a definition file:

1. From X Manager or X Manager for Domains, click **File > Import**.

2. Browse to your Windows user profile folder to locate the definition file that contains your migrated settings. The definition file name identifies the product and version whose settings were migrated. For example: Exceed 12_00.rxd.

   On Windows XP, the default location is: \Documents and Settings\<user>\.attachmate\rx\migration\n
   On Windows 7 and Windows Vista, the default location is: \Users\<user>\Documents\.attachmate\rx\migration\n
3. In the **Import Definitions** dialog box, select all the definitions.

4. Click **Import**.

---

**Note:** You can also migrate settings manually using the `rxmigrate` command line utility. This is useful if you have configured settings in a shared network location; these settings are not migrated automatically.

---

**Uninstall Reflection X Advantage**

---

**Note:** These procedures uninstall the Reflection X Advantage application. Reflection X Advantage databases, which contain your configuration information, are not removed.

---

**To uninstall on Windows**

1. Log on as an administrator.

2. From the **Windows Control Panel**, open **Programs and Features** (or **Windows Add or Remove Programs**, depending on your version of Windows.)

3. Select **Attachmate Reflection X Advantage**, click **Uninstall** (or **Remove**).

---

**To uninstall on UNIX**

1. Log on as root.

2. Open a terminal window and navigate to the `Uninstall_rxadvantage` directory, which is located in the Reflection X Advantage installation directory. The default location is:

   `/opt/rxadvantage/Uninstall_rxadvantage`
3. Enter the following command to initiate the uninstall and follow the uninstaller instructions.

```bash
./Uninstall_rxadvantage
```

Note: The command above launches the InstallAnywhere installation program which requires an X11 Windows display. To initiate a command line uninstall, you can add the parameters `-i console` as shown here:

```bash
./Uninstall_rxadvantage -i console
```

---

**To uninstall on a Mac**

- You can uninstall X Manager by moving the following application into the trash:
  
  `Applications > Reflection X Advantage > X Manager`

- If you're running Reflection X in domain mode, you need to stop the Reflection X service before you can uninstall some features. To stop the service, you'll need to open a terminal window. For details, see *Remove All Reflection X Files* (page 23).

**Remove All Reflection X Files**

Uninstalling Reflection X does not remove its associated files and directories. Use these procedures if you want to remove all associated files and directories.

---

**To remove files from a Windows installation**

1. In the `%ALLUSERSPROFILE%` folder, remove the `.attachmate` folder and all of its subfolders.

   **Note:** This folder contains the database and logs used by X Manager for Domains.

2. In the `%USERPROFILE%` folder of any user who has configured X Manager, remove the `.attachmate` folder and all of its subfolders.

   **Note:** This folder contains the database and logs used by X Manager.
To remove files from a UNIX installation

1. Delete the installation directory. The default location is:
   
   `/opt/rxadvantage`

   For example, navigate to the `opt` folder and enter:
   
   `rm -fr rxadvantage`

   Note: The `db` and `logs` subdirectories of the installation directory contain the database and logs used by X Manager for Domains.

2. Navigate to the home directory of any user who has configured X Manager and remove the `.attachmate` directory and all of its subdirectories:
   
   `rm -fr .attachmate`

   Note: The `.attachmate` directory located in the user's home directory contains the database and logs used by X Manager.

To remove a Mac installation

1. Open a terminal window.

2. If the Reflection X service is installed and running, stop the service:
   
   `sudo /Applications/Reflection X Advantage/rxs/bin/rxs stop`

3. Delete the X Manager for Domains database and logs:
   
   `sudo rm -fr /private/var/rx`

4. Delete the X Manager database and logs:
   
   `sudo rm -fr /Users/USER_NAME/.attachmate`

5. If the Reflection X service is installed, delete boot scripts.
   
   `sudo rm -fr /Library/StartupItems/RxService`

6. Delete Reflection X Advantage application folder:
   
   `sudo rm -fr /Applications/Reflection X Advantage`

7. Delete all previous Reflection X Advantage package files from the Receipts folder. The syntax depends on your version.

   Starting with Mac OS X 10.6:
   
   `sudo rm -fr /var/db/receipts/com.attachmate.rx.*`

   For earlier Mac OS X versions:
   
   `sudo rm -fr /Library/Receipts/Rx*.pkg`
Use XDMCP to access your host desktop

This procedure uses X Manager to access your UNIX desktop. See the notes below if you are using X Manager for Domains.

Note: XDMCP must be enabled on your UNIX host.

To connect using XDMCP

1. Start X Manager.

2. Under My Sessions on the left, select the default session, called "(Untitled Session)".

   Note: Click the plus sign (+) to create additional sessions.

3. In the Session Definition pane on the right, in the Session name box, enter a name for the session.

   The name you enter is saved automatically, and appears under My Sessions on the left.

4. From the On session start/reset options, select Initiate XDMCP.

5. From the Type box, select Direct.

6. In the Host name box, enter the name or IP address of your host.

7. From the toolbar, click to start your session.

   Note: You can also start a session by right-clicking the session name and clicking Start in the context menu, or by selecting the session name then clicking Action > Start.

8. Enter your login credentials for the host.
Note: Once a session is established, two small green arrows appear to the left of its name under My Sessions. Status information for the session is displayed in the Session Status section on the right.

Doing more with this idea...

Once you have established a connection, Reflection X supports a number of features you might want to try. For example:

- Share your session with other users. For details, see Share a Session in the Reflection X Help.
- Create a desktop shortcut that launches your session. For details, see Create Shortcuts in the Reflection X Help.

Notes for creating sessions using X Manager for Domains

- X Manager for Domains is not installed by default.
- X Manager for Domains does not include default session and server definitions. You'll need to create a server definition before you can create your first session definition. Click the plus sign (+) under X Servers to create a new server. Each new definition uses the same default values as the "Generic X Server" definition provided in standalone X Manager.

Run an X Client Application on your Windows Desktop

This procedure configures a session that establishes a Secure Shell connection to the host, runs an X client application on your Windows desktop, and closes automatically when you close the client.

These are the basic steps. They are explained below.

Step 1: Create a server definition.
Step 2: Create a client definition.
Step 3: Create and launch a session.

Use server definitions to configure your display preferences. For example, the following procedure creates a server definition that displays each client window directly on your Windows desktop.
Step 1: Create a server definition

Note: As you edit the server definition, changes are saved automatically.

1. Start X Manager.
2. In the left pane, click the plus sign (+) next to X Servers.
   
   A new server definition appears.
3. In the Server Definition pane on the right, open the Windowing area and select Show clients on my desktop.
4. In the General area, Name field, specify a name for this server, such as "Clients on desktop."
   
   The name you enter is automatically saved and appears under X Servers on the left.

The client definition identifies the host you want to connect to, how you want to make the connection, and which X client application (or applications) you want to run. The next steps show how to make a Secure Shell connection (the default) and launch an X client using one of the available sample command lines.

Step 2: Create a client definition

Note: As you edit the client definition, changes are saved automatically.

1. From X Manager, in the left pane, click the plus sign (+) next to X Clients.
   
   A new client definition appears.
2. From the Client Definition pane on the right, enter a name for your client definition.
   
   The name you enter is saved automatically, and appears under X Clients on the left.
3. For Host name, specify the name or IP address of the computer that hosts your X client application.
4. Select a Host type from the drop-down list.

Note: Changing the host type changes the list of sample client commands available in the Command drop-down list.
5 The default value for Connection method is Secure Shell. Leave this option selected.

---

Note: The Secure Shell protocol (also known as SSH) provides a secure alternative to Telnet and other unsecured protocols commonly used to connect to X Windows hosts. Secure Shell connections require both server and user authentication, and all communications pass between hosts over an encrypted communication channel. Most hosts support this connection method. If your host does not, you may need to choose one of the other options.

6 Type in your user name, and password for the host.

7 From the Application box, select Single command.

8 In the Command text box, use the drop-down list to select one of the sample commands for starting an X client.

The session definition specifies which X server to use and which client (or clients) to start whenever you run this session. The session defined below also stops automatically when you close the client application.

---

**Step 3: Create and launch a session**

1 In the left pane, click the plus sign (+) next to My Sessions.
   A new session definition appears.

2 Select the session definition, and then enter a session name on the right.

3 From the Use X server list, select the server definition that you created earlier.

4 Set On session start/reset to Start X clients.

5 Click the plus sign (+) next to X Clients.
   The Add Clients dialog box appears.

6 From the Add Clients dialog box, select the client definition you just created, and then click OK.

7 From the On last client list, select Stop Session. (When this option is selected, your session stops automatically when you close your client application.)

8 From the toolbar, click to start your session. (You can also start a session by right-clicking the session name and clicking Start in the context menu, or by selecting the session name then clicking Action > Start.)
Note: The first time you connect to a host using Secure Shell, you see a **Host Key Unknown** dialog box. This indicates that the key required to authenticate this host is not yet included your host key database. The administrator of the host can use the fingerprint displayed in this dialog box to help you confirm that you are connecting to the correct host. If you click **Always** in response to this prompt, the key is added to your known host key database and you won't see this prompt again.

**Doing more with this idea...**

Once you have established a connection, Reflection X supports a number of features you might want to try. For example:

- Share your session with other users. For details, see Share a Session in the Reflection X Help.

- Create a desktop shortcut that launches your session. For details, see Create Shortcuts in the Reflection X Help.
Running Reflection X in domain mode provides a number of potential advantages. This section introduces you to some basic domain configurations that offer solutions to common problems.

**Domain Setup: Improve Performance Over a Slow Network**

This sample configuration demonstrates how you can configure a Reflection X domain to improve performance where high latency or low bandwidth in your network connections cause delays that make running a remote X client application difficult.

Before you start, it's a good idea to be comfortable with basic session configuration using X Manager. For help getting started, see *Getting Connected* (page 25).
In this configuration, the session runs two joined X servers. An X server display runs on the user workstation (1). This server creates the visual display of the X client application. An additional headless X server (page 102) (3) runs on a domain node located on or near the X client application. When a session is established, all X protocol passes between the X client application (4) and the headless server. Only the protocol required to update the display is sent to the workstation. Because many X protocol queries don't need to be sent to the workstation, this configuration improves performance by reducing the amount of traffic that needs to pass over the network. Reflection for Secure IT also automatically detects low bandwidth conditions, and compresses protocol that flows between the user workstation (1) and the domain node (3).

The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User workstation (1)</td>
<td>Runs X Manager for Domains. The X server display is created on this computer.</td>
</tr>
<tr>
<td></td>
<td>When this workstation is located a long distance from the X client host, high latency is a common problem. Without the domain configuration described below, the user sees poor performance when trying to interact with the X client application.</td>
</tr>
<tr>
<td>Domain controller (2)</td>
<td>Runs the Reflection X domain controller. (In this example, the Administrative Console also runs on this computer.) Session definition information is stored here and used to create a session on the domain node.</td>
</tr>
</tbody>
</table>

The domain controller can be installed on the X client host, or on a nearby computer.
Chapter 4  Getting Started with Reflection X Domains

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain node (3)</td>
<td>Runs a headless X server. This headless server communicates with the X client application and sends required data to the X server display on the user workstation.</td>
</tr>
<tr>
<td></td>
<td>The domain node can be the X client host, or a nearby computer.</td>
</tr>
<tr>
<td>X client host (4)</td>
<td>The computer that runs the X client application.</td>
</tr>
</tbody>
</table>

These are the basic steps for setting up this configuration. They are explained below.

- Step 1: Install Reflection X domain features.
- Step 2: Configure the Reflection X domain.
- Step 3: Configure and start your session.

**Step 1: Install Reflection X domain features**

- Install the following Reflection X features.

<table>
<thead>
<tr>
<th>On this computer</th>
<th>Install these features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain controller</td>
<td>Administrative Console</td>
</tr>
<tr>
<td></td>
<td>X Manager for Domains</td>
</tr>
<tr>
<td></td>
<td>Reflection X Service &gt; Run Domain Controller</td>
</tr>
<tr>
<td>Domain node</td>
<td>Reflection X Service &gt; Allow Sessions</td>
</tr>
<tr>
<td>User workstation</td>
<td>X Manager for Domains</td>
</tr>
</tbody>
</table>

**Notes:**

- The features listed above are not included in a default installation.
- You may choose to install additional features. The features listed above are just those that are required for this sample domain configuration. You can run any or all Reflection X features on the same computer. For example, you may want to install both X Manager for Domains and X Manager on the user workstation.
Step 2: Configure the Reflection X domain

1. From the domain controller, start the Administrative Console and log on.
   - For **Username** and **password**, enter the same credentials you used to log onto this computer.
   - For **Domain**, enter this computer name. (The Reflection X domain name is always the same as the name of the computer running the domain controller.)

2. From the tabs located along the left-hand side of the window, click **Authentication**.

   Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X domain administrator.

3. **Configure user authentication for your Reflection X domain** (page 44).

   Note: If you're running on Windows, **Authentication system** is set to Windows by default. This default authentication system lets you leverage your existing Windows domain to handle user authentication. If your Reflection X domain users are all members of the same Windows domain, no additional configuration is required.

4. From the tabs located along the left-hand side of the window, click **Domain Composition**.

5. Under **Domain Nodes**, click +.

6. In the **Add Domain Node** dialog box, for **Host name**, specify the name or IP address of your domain node. Use the **Friendly name** box to specify how you want this computer to show up in your **Registered Nodes** list. Click **OK**.

Step 3: Configure and start your session

1. From the administrator workstation, start X Manager for Domains and log on using the same credentials and domain name you used to log on to the Administrative Console.

2. Create and configure a session that launches your X client application, or uses XDMCP to access your UNIX desktop.

3. Under **My Sessions**, select your session.

4. In the **Session Definition** pane, under **Domain services**, select a level of domain services that includes **High-latency network performance**.

   Note: At this level of domain services, the domain controller starts a session only if it can create a session on a registered domain node. This requires at least one domain node that is configured to allow sessions.
5 Start your session.

In the **Session Status** area, under **X Servers**, you will see an entry for your workstation computer. If high latency is detected in your network connection, you'll see an additional entry for the headless X server. The headless X server will be located on the domain node.

**Doing more with this idea...**

Once you have this basic configuration running, you can build on it in a number of ways. For example:

- Add additional workstations to the domain and simplify connections for end users by configuring public sessions (page 39).
- Add scalability by adding additional domain nodes.

**Domain Setup: Leave a Session and Rejoin from a Different Computer**

This sample configuration demonstrates how you can configure a personal Reflection X domain that makes it easy for you to continue working from home on a session you started on your work computer. You can pick up your work exactly where you left off.

Before you start, it's a good idea to be comfortable with basic session configuration using X Manager. For help getting started, see *Getting Connected* (page 25).
The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office computer (1)</td>
<td>Runs the domain controller, X Manager for Domains, and the Administrative Console. You can access your sessions from any computer running X Manager for Domains that has access to this computer.</td>
</tr>
<tr>
<td>Home computer (2)</td>
<td>Runs X Manager for Domains.</td>
</tr>
<tr>
<td>X client host (3)</td>
<td>The computer that runs the X client application.</td>
</tr>
</tbody>
</table>

These are the basic steps for setting up this configuration. They are explained below.

1. Install Reflection X domain features.
2. Configure the Reflection X domain.
3. Configure and start a session at work.
4. Join your session in progress from your home computer.

**Step 1: Install Reflection X domain features**

- Install the following Reflection X features.

<table>
<thead>
<tr>
<th>On this computer</th>
<th>Install these features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office computer</td>
<td>Administrative Console</td>
</tr>
<tr>
<td></td>
<td>X Manager for Domains</td>
</tr>
<tr>
<td></td>
<td>Reflection X Service (all features)</td>
</tr>
<tr>
<td></td>
<td>&gt; Run Domain Controller</td>
</tr>
<tr>
<td></td>
<td>&gt; Allow Sessions</td>
</tr>
<tr>
<td>Home computer</td>
<td>X Manager for Domains</td>
</tr>
</tbody>
</table>

Notes:

- The features listed above are not included in a default installation.
- You may choose to install additional features. The features listed above are just those that are required for this sample domain configuration. You can run any or all Reflection X features on the same computer. For example, if you previously installed standalone X Manager (the default), you can add domain features without uninstalling X Manager.
Step 2: Configure the Reflection X domain

1. From your office computer, start the Administrative Console and log on.
   - For **Username** and **password**, enter the same credentials you used to log onto this computer.
   - For **Domain**, enter this computer name. (The Reflection X domain name is always the same as the name of the computer running the domain controller.)

2. From the tabs located along the left-hand side of the window, click **Authentication**.
   
   Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X domain administrator.

   Note: For this basic configuration, you don't need to make any changes to this default authentication configuration and you don't need any additional users.

Step 3: Configure and start a session at work

1. From your work computer, start X Manager for Domains and log on with the same user name and password you used for the Administrative console. For domain, specify the name of your office computer.

2. Create and configure a session to connect to your UNIX desktop or client application.

   Note: Unlike the standalone X Manager, X Manager for Domains includes no default server definitions. You need to create at least one server definition before you can configure and start a session.

3. Under **My Sessions**, select your session. In the **Session Definition**, under **Domain services**, select **Session suspend/resume**.

4. Start your session and get some work done. When it's time to go home, close X Manager and leave the computer running.

   Note: Because you enabled session persistence, the server remains active even though it is no longer producing a display. To confirm this, you can start the Administrative Console, click the **Domain Status** tab and view **Running Sessions**.
Step 4: Join your session in progress from your home computer

1. Connect your home computer to your Virtual Private Network.

2. Start X Manager for Domains and log on with the same user name and password you used on your office computer. For domain, specify the name of your office computer.

Persisting a Session on a Remote Computer

In the configuration shown above, the session components run on your office computer, which means that you need to leave that computer running if you want to rejoin the session from home. To be able to rejoin a session even after you shut down your office computer, you can configure Reflection X to run the session components on a remote domain node. The configuration described in Domain Setup: Improve Performance Over a Slow Network (page 31) describes one possible configuration to support this.

Another possible configuration is shown below. In this configuration, the domain controller is installed on the same computer that runs the X client application. With this setup, you can leave your session and shut down both your home and office computer and the session will remain active on the client host.
Domain Setup: Centralize Session Configuration

This sample configuration demonstrates how an administrator can use a Reflection X domain to simplify session setup for end users.

Before you start, it's a good idea to be comfortable with basic session configuration using X Manager. For help getting started, see *Getting Connected* (page 25).

In this example, the administrator configures public session definitions. End users can launch these public sessions from their workstations, and can also create and start their own sessions.

The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Workstation (1)</td>
<td>Runs the Administrative Console and X Manager for Domains. The administrator uses these to manage the domain, and to configure and share public session definitions.</td>
</tr>
<tr>
<td>Domain Controller (2)</td>
<td>Runs the Reflection X domain controller. Session information is stored on this computer in the domain controller database.</td>
</tr>
<tr>
<td>User workstations (3)</td>
<td>Run sessions configured by the administrator and optionally create additional private sessions.</td>
</tr>
<tr>
<td>Domain nodes (4)</td>
<td>(Optional) Run remote session components when sessions are configured to use domain services.</td>
</tr>
<tr>
<td>X client host (5)</td>
<td>The computers that run X applications used in your organization.</td>
</tr>
</tbody>
</table>
The administrator uses the Administrative console (1) to configure the domain controller (2). When users start sessions, the domain controller can set up session components on user workstations (3) or domain nodes (4):

The X server displays are created on user workstations using the centrally managed configurations:
These are the basic steps for setting up this configuration. They are explained below.

Step 1: Install Reflection X domain features.

Step 2: Use the Administrative Console to configure the Reflection X domain.

Step 3: Use X Manager for Domains on the administrative workstation to configure and test a session.

Step 4: Use the Administrative Console to make the session public.

Step 5: Use X Manager for Domains on the user workstation to connect using the public session.

---

**Step 1: Install Reflection X domain features**

- Install the following Reflection X features:

<table>
<thead>
<tr>
<th>On this computer</th>
<th>Install these features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Workstation</td>
<td>Administrative Console</td>
</tr>
<tr>
<td></td>
<td>X Manager for Domains</td>
</tr>
<tr>
<td>Domain controller</td>
<td>Administrative Console</td>
</tr>
<tr>
<td></td>
<td>Reflection X Service &gt; Run Domain Controller</td>
</tr>
<tr>
<td>User workstations</td>
<td>X Manager for Domains</td>
</tr>
<tr>
<td>Domain nodes</td>
<td>Reflection X Service &gt; Allow Sessions</td>
</tr>
</tbody>
</table>

---

**Notes:**

- The features listed above are not included in a default installation.

- You may choose to install additional features. The features listed above are just those that are required for this sample domain configuration. You can run any or all Reflection X features on the same computer. For example, you may want to install both X Manager for Domains and X Manager on the administrative workstation.
Step 2: Configure the Reflection X domain

1. From the domain controller, start the Administrative Console and log on.
   - For **Username** and **password**, enter the same credentials you used to log onto this computer.
   - For **Domain**, enter this computer name. (The Reflection X domain name is always the same as the name of the computer running the domain controller.)

2. From the tabs located along the left-hand side of the window, click **Authentication**.

   Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X domain administrator.

3. **Configure user authentication for your Reflection X domain** (page 44).

   Note: If you're running on Windows, **Authentication system** is set to Windows by default. This default authentication system lets you leverage your existing Windows domain to handle user authentication. If your Reflection X domain users are all members of the same Windows domain, no additional configuration is required.

4. If you are using domain nodes to support domain services (such as session persistence and improved performance), you need to add the nodes to the domain as follows.
   a) From the tabs located along the left-hand side of the window, click **Domain Composition**.
   b) Under **Domain Nodes**, click +.
   c) In the **Add Domain Node** dialog box, for **Host name**, specify the name or IP address of each of your domain nodes. Use the **Friendly name** box to specify how you want these computers to show up in your **Registered Nodes** list. Click **OK**. (Under **Registration Details**, both **Participate in domain** and **Run sessions** are selected by default. Leave these settings selected.)

Step 3: Configure a session from the administrative workstation

In the steps that follow, you'll use X Manager for Domains to configure and test a session for connecting to one of your UNIX hosts.

Note: It is also possible to create session definitions using the Administrative Console, but starting with X Manager for Domains makes it easy to test your session configuration.
1. From the administrator workstation, start X Manager for Domains and log on using the same credentials and domain name you used to log on to the Administrative Console.

2. Create and configure a session to connect to your UNIX desktop or client application. (If you are configuring your first session, you'll need to create at least one server definition. Unlike X Manager, X Manager for Domains includes no default server definitions.)

   Note: If you are creating new client definitions, you should leave **User name** blank because you are going to share this session definition with others. After you make this session public, users can enter their name during the connection process.

3. (Optional) If you have configured domain nodes to support domain services, select one of the Domain Services options for this session.

4. Start your session.

   If your connection is successful, you're ready to make this session definition available to other users.

---

**Step 4: Make the session public**

By default, a new session is private. A private session definition can be viewed, used, and modified only by the user who created it. To make your session available to other users, you need to make it public.

Note: When you make a session public, users also need access to the associated server definition and any client definitions it uses.

1. From the administrator workstation, start the Administrative Console and log on.

2. Right-click the session definition and select **Public**. Note that the icon changes to indicate that this is now a public session.

3. Right-click the server definition and select **Public**.

4. If your session uses any client definitions, make these public in the same way.

Now that the administrator's work is done, all a user needs to know to get connected is:

- Logon credentials for the Reflection X domain. (If you manually added users to the internal authentication database, you need to provide them with these credentials. If you use Windows or PAM for authentication, users can log on to the Reflection X domain using those credentials.)

- The name of the Reflection X domain. (The name of the computer running the domain controller.)

- Logon credentials for the X client host.
Here's how it works...

**Step 5: Make a connection from the user workstation using the public session**

1. From the user workstation, start X Manager for Domains. Log on using the log on and domain name values provided by the administrator.

2. Under *My Sessions*, find the session made public by the administrator. Highlight it and start the session.

**Configure and Test User Authentication**

Reflection X Advantage supports the following authentication methods: Windows, PAM (Pluggable Authentication Modules), LDAP (Lightweight Directory Access Protocol), and Reflection X Internal.

The default Reflection X authentication method depends on the operating system of the computer on which you installed the domain controller. On a Windows computer, Windows authentication is used. On a UNIX or Mac computer, PAM authentication is used.

Use the Administrative Console to test and configure user authentication. Two procedures to help you get started are outlined here: testing the default authentication on Windows computers and configuring Internal authentication. For additional information, see *Set Up Domain Authentication* (page 65).

If you install your domain controller on a computer that is joined to a Windows domain, users with accounts in the same Windows domain can log on to the Reflection X using their Windows domain credentials. No additional configuration is needed. You can use the following procedure to test user authentication to the Reflection X domain.

**To test authentication using Windows credentials**

1. Start Reflection X Administrative Console and log on to the Reflection X domain.

2. From the tabs located along the left-hand side of the window, click *Authentication*.

3. Click *Test Authentication* and enter credentials for any valid Windows domain user.

The internal authentication system is a light-weight authentication system that is available on all supported platforms. You may find it useful for testing or to set up a domain for a small group of users.
To configure Internal authentication

1. Start Reflection X Administrative Console and log on to the domain.

2. From the tabs located along the left-hand side of the window, click Authentication.

   Notice that your name is already added to the list of user accounts and is selected as the administrator. The first user to log on to the Administrative Console is the default domain administrator.

3. Set Authentication system to Internal.

4. Click (or Action > Set user's password) to set your password in the Internal authentication database.

   Note: Although an administrator account was created when you first logged on, the internal authentication database has no record of your password for this account because authentication was handled by Windows or PAM. You need to manually add users and set passwords when you use Reflection X Internal authentication. This is not required for the other authentication methods because authentication for Windows, PAM, or LDAP is managed by those systems. If you change to Internal authentication from the default authentication, any user who was added automatically will not be able to log on until you set a password for that user.

5. Click Test Authentication and enter your credentials to confirm that you can still log on to the domain using this account.

   Caution: After changing the authentication system, always test the administrator account before you log off. Without a valid administrator account, you won't be able to log onto the domain. (If you do find yourself locked out of your domain, a recovery utility (page 69) is available.)

6. Click (or Action > New User) to add additional users to your domain. Enter a username and password for each user.
The X Manager Interface

The X Manager interface is designed to be easy to use and customizable.

The Navigation and Definition Panes

When you first start X Manager, you see a navigation pane on the left that allows you move among definition panes on the right.

- **Navigation pane** — This pane contains the following sections:
  
  **My Sessions**
  
  This section may include either running sessions that you have started, joined, or left (X Manager for Domains), or session definitions (configurations settings for a session that is not running).

  When you first start X Manager, if you have migrated settings from Reflection X version 13 or 14, or from a Hummingbird Exceed product, you may see migrated session definitions.

  (X Manager for Domains) You may see a *public session definition* (page 104) created for you by an administrator.

  **Note:** To start, join, or leave a session, select it, right-click, and then choose the appropriate command.

  **Offered Sessions**
  
  (X Manager for Domains) If a session appears in this category, it's a session that another domain user has offered to you that you have or have not joined.
This section contains the client definitions (configuration settings for a client) that you create.

When you first start X Manager, if you have migrated settings from Reflection X version 13 or 14, or from a Hummingbird Exceed product, you may see migrated client definitions.

(X Manager for Domains) If your administrator has created public client definitions for you, they will be present in this section.

### X Servers

In X Manager, this section contains the default server definition **Generic X Server**, and any server definitions you create.

When you first start X Manager, if you have migrated settings from Reflection X version 13 or 14, or from a Hummingbird Exceed product, you may see additional server definitions.

(X Manager for Domains) If your administrator has created public server definitions for you, they will be present in this section.

---

**Note:** To create a customized X server instance, clone an existing X server definition and edit the copy. Or, create a new instance of the X server by clicking the plus sign (+).

---

- **Definition panes** — The information that appears corresponds to the definition or session highlighted in the navigation pane to the left. When you highlight:
  - A definition that you own, you can edit it.
  - (X Manager for Domains) A public definition (a definition that is owned by your administrator), you cannot edit it.
  - A running session, you can view only **Session Status** and the settings for that session; you cannot change the way a session is configured until you stop it.

---

**Note:** As you make edits, observe that there are no OK or Apply buttons — your changes are automatically saved.

---

### Customizing Your View

You can customize your view from the **Edit Preferences** dialog box, by hiding certain sections of the navigation pane, or changing the order in which they appear.
Reflection X Icons

The icons displayed in the left panel of X Manager — under My Sessions, Offered Sessions, X Clients, and Servers — show the status of the X Manager components available to you.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Session definition](image) | **Session definition**  
Configuration settings for a session. This session is not running. |
| ![Public session definition](image) | **Public session definition**  
Session definition created by the administrator, and available to all users in the domain. This session is not running. |
| ![Session, currently running and joined](image) | **Session, currently running and joined**  
The session has been started, and is currently being viewed on this computer. This session may appear under My Sessions or Offered Sessions. |
| ![Session, currently running and available to be joined](image) | **Session, currently running and available to be joined**  
The session has been started, but is not currently being viewed on this computer. This session may appear under My Sessions or Offered Sessions. |
| ![X client definition](image) | **X client definition**  
Configuration settings for starting an X client application. |
| ![Public X client definition](image) | **Public X client definition**  
X client definition created by the administrator, and available to all users in the domain. |
| ![Server definition](image) | **Server definition**  
Configuration settings for an X server. |
| ![Public server definition](image) | **Public server definition**  
Server definition created by the administrator, and available to all users in the domain. |

When working with Fonts, Secure Shell Keys, and Color Schemes, the following icons display:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![User key](image) | **User key**  
Secure Shell user key pair for connection to X clients. |
| ![Trusted host key](image) | **Trusted host key**  
Secure Shell host public key for connections to X clients. |
| ![Public trusted host key](image) | **Public trusted host key**  
Secure Shell host public key created by the administrator, and available to all users in the domain. |
### Reflection X Advantage

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| 📚 | **Font collection**  
Font file set collection for use by X servers. |
| 🚚 | **Public font collection**  
Font file set collection created by the administrator, and available to all users in the domain. |
| 🎨 | **Color scheme**  
Configuration settings for colors in a color scheme, which can be used by an X server. |
| 🆚 | **Public color scheme**  
Color scheme created by the administrator, and available to users in the domain. |

The following icons appear on the Windows desktop when you create shortcuts:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| 🖥️ | **Session shortcut**  
Starts a specified session. |
| 🐣 | **Client shortcut**  
Starts a specified X client and an associated session. |

The following icons appear in the Administrative Console:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| 🔐 | **Set user password**  
Available from the Authentication pane when Authentication system is set to Internal. |
| 🌐 | **Registered node** (online)  
On the Domain Composition pane. Indicates that the listed domain node is online. |
| 🌐 | **Registered node** (not online)  
On the Domain Composition pane. Indicates that the listed node is not available. |
Understanding Session Definitions

Session definitions are located under My Sessions in the left pane of X Manager.

A session definition includes a server definition that specifies the configuration settings for an X server. It can also include one or more client definitions that contain the settings for starting X client applications.

Use session definitions to establish sessions with X client applications. When you select a session definition that contains only a server definition, Reflection X starts an X session and leaves it to you to log in to the host and start an X client application. A session definition that contains both a server and one or more client definitions starts an X session and launches the X client applications, connecting them to the X server.

There are two types of session definitions:

- **Private session definitions**: Visible only to the user who owns it, and can be edited only by that user.

- **Public session definitions**: Visible to all users in the domain (page 102), but can only be created or edited by the administrator. Public definitions are available only when operating Reflection X in domain mode.

Notes:

- A session definition can be edited only by the user who created the session.

- Only domain administrators can create public session definitions. The domain administrator must be the owner of the definition to make it public.

- Any user can use the Export/Import Definitions features in Reflection X to share private definitions with another user.

Frequently Asked Questions

**Can I edit my session definition while a session is running?**

No. You must stop the session before you can edit the session definition.

**Can I edit my client definition while a session using that definition is running?**

Yes. However, it will have no effect on the currently running client — your edited client definition will be used the next time you start a new session that uses that client definition, or when you manually start it against a session.
Can I edit my server definition while a session using that definition is running?
Yes. However, it will have no effect on the current session — your edited server definition will be used the next time you start a new session that uses that server definition.

Does a session definition require a client definition?
No. It's optional. If no client definition is present, no clients are automatically started.

Can a session definition start more than one client application?
Yes. You can add several client definitions to the same session definition.

Can I make a definition public?
The ability to create public definitions (page 104) is available when using the Reflection X Administrative Console, and is limited to administrators only.

Can users other than administrators offer to share sessions with other users?
Anyone who starts a session can offer to share it with other users.

How and where are my settings saved?
Settings are saved automatically to the Reflection X Advantage database (page 52) while you work.

Reflection X Advantage Database Files

Reflection X Advantage stores configuration information in database files. Settings are saved automatically while you work.

Administrators are not required to perform any direct maintenance for this database. However, it may be appropriate to include this folder in your site's general backup or archiving procedures.

X Manager database files

The database files for the standalone X Manager are stored in the following user-specific locations.

On Windows systems:
The database files are located in the Windows user profile folder. The default location for these files depends on your version of Windows. For example:

C:\Documents and Settings\<user>\.attachmate\rx\db
-OR-
C:\Users\<user>\.attachmate\rx\db

On UNIX systems:
The database files are in:

$HOME/.attachmate/rx/db
On Mac systems:

The database files are in:

/Users/<user>/.attachmate/rx/db

**Domain database files**

The database files for a Reflection X Advantage domain are located on the computer that is functioning as the *domain controller* (page 102).

---

**Note:** To ensure that backed up files are consistent across the database file set, stop the Reflection X Advantage service before making a backup of the domain database.

---

On Windows systems:

The domain database files are located in the Windows All users profile folder. The default location for this file depends your version of Windows. For example:

C:\Documents and Settings\All Users\.attachmate\rx\db

-OR-

C:\ProgramData\.attachmate\rx\db

On UNIX systems:

The domain database files are in:

/opt/rxadvantage/rx/db

On Mac systems:

The domain database files are in:

/private/var/rx/db
CHAPTER 6

Planning a Reflection X Domain

In this Chapter

Reflection X Domain Components 55
Reflection X Session Components 57
Data Flow for a Basic Session 58
Data Flow for a Distributed Session 59
Determining the Domain Components to Install 62
Best Practices for Designing a Reflection X Domain 62
Configure Reflection X Domain Nodes 64
Set Up Domain Authentication 65
Deploy with Java Web Start 70

A Reflection X domain consists of one or more computers on which X session components run and are load-balanced. The domain also defines a group of users who can run and share sessions on those computers.

Reflection X domains can be set up in many different ways, with several optional components. To review some sample domain configurations, see Getting Started with Reflection X Domains (page 31). Use the information in this section to better understand the parts of a domain and what role they play.

Reflection X Domain Components

A Reflection X domain typically involves more than one computer, each running one or more of the following components.

The Administrative Console
Installed on one or more administrator workstations, this application is used by domain administrators to set up and centrally manage the domain. From the console, administrators can control domain access and manage public session definitions (X client and X server configuration settings). Using this application, administrators can also monitor sessions, session components, and load information.
X Manager for Domains
Installed on the computers of domain users. With this application the user can join Reflection X domains, start X sessions defined in the domain database, and/or define and start his or her own sessions.

Domain Controller
To create a domain controller, install the Reflection X Service with Run Domain Controller selected.

After installation, the Reflection X service starts the domain controller process, which runs continuously and listens for requests to access the domain.

The database (page 52) that centrally stores session definitions and session information is created and maintained on this computer.

Note: Each domain must have one domain controller.

Domain Node
A domain node is a computer available to the domain that provides domain services (such as session suspend/resume, or network fault tolerance) to sessions.

When you start a session using X Manager for Domains, the domain controller sets up the components required to run that session. If Domain services for the session is set to None, these session components run on the same computer as X Manager for Domains, otherwise they run on a remote domain node. Sessions that are configured to use domain services always require access to at least one remote domain node.

To create a domain node, install the Reflection X Service with Allow Sessions selected.

X client host
This is the computer running your X client application.

Note: Because Reflection X can be installed on UNIX computers, you can configure this computer to run any or all of the X Manager for Domains components described above.
Reflection X Session Components

In Reflection X Advantage, a traditional X server is broken into several cooperating processes — a client connector, protocol router, and one or more X servers. This combination of processes is referred to as an "X session." When Reflection X runs in Standalone mode, all processes initially run on the user's workstation. However, when Reflection X runs in Domain mode, these processes may be distributed among different computers.

Client Connector and Protocol Router

The client connector and protocol router run together on the same computer. The client connector receives X protocol data from the X client application, converts it to a proprietary Reflection X protocol, and then sends it to the protocol router.

The protocol router serves as the hub of traffic for a Reflection X session — it transmits the protocol it receives from the client connector to all of the X servers in the session.

When Domain services is set to None (the default), these session components run on the X Manager for Domains workstation. When any other Domain services option is selected, these components run on a domain node (page 64).

X Server

The X server receives and processes data from the protocol router. Reflection X has two types of X servers:

**X server display**

This server creates the X client application display and returns user input (for example, keyboard or mouse) to the protocol router, which sends it on to the client program. A shared session may have multiple X server displays.

**Headless X server**

This server has no physical display, yet processes all X protocol. When enabled, the headless X server can short-circuit inquiry-only requests, removing the need to forward these requests across slow connections to X server displays on user desktops. When a session is suspended, the headless server keeps it alive by continuing to process client requests.

To see where these components are created on the computers in a Reflection X domain, refer to the following diagrams.

- Session diagram for a basic session (page 58) (all session components running on the same computer)
- Session diagram for a distributed session (page 59) (some session components run on a remote domain node)
Data Flow for a Basic Session

A basic session is one in which all session components run on the user's workstation (except for remote X server displays that are created when a session is shared). In standalone mode, this is the only type of session permitted; the client connector, protocol router and main X server display all run on the user's workstation. You can also create basic sessions in Domain mode, in which all session components run on the user's workstation. This is the default configuration for new sessions. Although session persistence and protocol compression features are not available, users can access public definitions provided by the administrator to run predefined sessions, or create and run their own customized private sessions. All public and private definitions are stored in a database on the domain controller and can be accessed from any computer in the domain.

For a basic session, **Domain services** is set to **none**. Here is the sequence of events:

1. When a user logs on to a domain, the domain controller authenticates the user, after which the user can access session definitions stored in the domain database.

2. When a user starts a basic session, the domain controller sets up the session components on the user workstation.

3. The X protocol flows directly from the X client to the session on the workstation.
Supporting Basic Sessions Only

To support basic sessions only, install Reflection X components per the following:

<table>
<thead>
<tr>
<th>Install</th>
<th>On</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X Manager for Domains</strong></td>
<td>All domain user workstations.</td>
</tr>
<tr>
<td>The <strong>Reflection X Service</strong>, configured with <strong>Run Domain Controller</strong></td>
<td>The Reflection X domain controller.</td>
</tr>
</tbody>
</table>

Data Flow for a Distributed Session

Distributed sessions can provide several advantages over basic sessions, including session persistence and improved performance in high latency or low bandwidth networks.

All of the following **Domain services** options create a distributed session. In a distributed session, the client connector and protocol router are created on a domain node, not on the workstation running X Manager for Domains. Each of these options also supports creating a headless X server on that domain node. The difference between the options is in how they control creation of the headless X server.

- **Session suspend/resume**

  A headless X server is created on the domain node only when you leave the session or close X Manager for Domains. This enables you to rejoin the session at a later time.

- **Session suspend/resume; High-latency network performance**

  Reflection X automatically measures the latency of the connection and creates a headless X server if the delay is significant enough to affect performance. The headless X server helps improve performance by reducing the amount of data that needs to pass over the network.

- **Session suspend/resume; High-latency network performance; Network fault tolerance**

  This option forces creation of a headless X server whenever the session is running. This can improve performance where high-latency is a concern and also ensures that the session remains running even if a workstation is disconnected due to a power or network failure.
Here is the sequence of events when **Session suspend/resume; High-latency network performance; Network fault tolerance** is enabled:

1. The user logs into the domain.
2. When the user starts a session, the domain controller sets up the session components (a client connector, protocol router, and possibly a headless X server) on a domain node that is configured to allow sessions. It also starts an X server on the user's workstation.
3. The X client starts and establishes a connection with the client connector. All X protocol passes to the headless X server on the domain node.
4. The X protocol required to maintain the display is passed on to the X server display on the workstation.
Note: In high latency networks, this configuration improves performance by short circuiting some of the data exchange. When a headless X server is running, client/server exchanges that aren't required to create the display pass between the client and the headless X server, but aren't sent on to the X server display on the workstation. This reduces the number of round trip network messages and neutralizes the effect of latency.

Compression to Remote Workstations

If you are connecting over a low bandwidth network, protocol compression can improve performance. Reflection X is configured by default to compress protocol to remote X servers automatically whenever it detects low bandwidth (Compress protocol to remote X server displays = Dynamic). When you configure a distributed session (as shown above), the protocol that passes between the domain node and the workstation (identified with the label 4 in the diagram above) can be compressed.

Supporting Domain Services

To support session persistence, improved performance on slow networks, and/or fault tolerance, install the following:

<table>
<thead>
<tr>
<th>Install</th>
<th>On</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Manager for Domains</td>
<td>All domain user workstations.</td>
</tr>
<tr>
<td>Reflection X Service</td>
<td></td>
</tr>
<tr>
<td>Run Domain Controller</td>
<td>The Reflection X domain controller.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Reflection X Service</td>
<td>All domain nodes.</td>
</tr>
<tr>
<td>Allow Sessions</td>
<td></td>
</tr>
<tr>
<td>Administrative Console</td>
<td>Domain controller and/or administrator</td>
</tr>
<tr>
<td>X Manager for Domains</td>
<td>workstation</td>
</tr>
</tbody>
</table>
Determining the Domain Components to Install

Review this chart to determine which features you need to install on computers in your domain.

<table>
<thead>
<tr>
<th>All domains</th>
<th>Session Persistence or Improved Performance for High-latency networks</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image of chart]</td>
<td></td>
</tr>
</tbody>
</table>

Best Practices for Designing a Reflection X Domain

Use the following guidelines to design the domain for your installation requirements.

Selecting Computers to Include in the Domain

When you select the computers to add as domain nodes, consider the following computer characteristics:

- Available system memory (computers that are dedicated require less memory than shared resources)
- Available processing power (computers that are dedicated require less processing power than shared resources)
- Reliability (choose domain nodes that run continuously and reliably)
- Clearance to run the Reflection X Service (security issues are most likely minor because these computers are typically inside a firewall)
- Speed of network connections. (If possible, Reflection X domain nodes should have good bandwidth and low latency connections to client application hosts.)

Adding Computers to the Domain

The number of domain nodes (computers) that your domain requires depends on the level of domain services that users typically select for their sessions.

None

No domain nodes are required when domain services is set to None — the domain controller stores definitions, but all other session components run on the user's workstation.

Session suspend/resume

With any of the domain services options listed above, add additional domain nodes as needed to maintain satisfactory performance. When domain nodes run more than one session at a time, the degradation of performance depends on factors such as the number of users running graphically-intensive X client applications and the availability of memory and processing power (if computers are used by other applications, more computers are required).

Note: Reflection X includes features that help you manage the load on domain nodes. For details, see Configure Load Balancing.

Designating a Computer as the Domain Controller

The domain controller is the "brain" of the domain. It keeps track of which nodes belong to the domain, communicates with X Manager for Domains, and starts the Reflection X components required for the session. By default, it also acts as the first node in a domain. When a user starts a session, the X server on his or her workstation requests the domain controller to set up the session. The domain controller then determines which computers to use for each software component, and starts each component.

For the domain controller, choose a computer that has the following characteristics:

- Reliability
- Good bandwidth network connections
- Good processing capacity
- High availability
Setting Up More than One Domain

When users need to share only certain session definitions within an organization or group, you will need to create more than one domain.

This would be valuable if your company wanted to restrict information between departments; for example, you could restrict access to the confidential designs and other proprietary material with which the Engineering R&D department often works from departments such as Marketing and Accounting, but allow those departments access to other necessary X applications.

You cannot install more than one domain controller on a computer (if you set up more than one domain, you will need to use a separate computer for each domain controller). You can, however, use a computer as a domain node for more than one domain.

Configure Reflection X Domain Nodes

You will need to add the computers that you have designated as domain nodes to the domain.

Before you Start

- On each of the computers that you plan to use for domain nodes install the Reflection X Service with Allow Sessions selected.
- Make sure you have administrative privileges on the computer you have designated as the domain controller for access to the Reflection X installation folder (for example, %ProgramFiles%\Attachmate\Reflection X Advantage).

To configure domain components

1. On the computer on which you have installed the Reflection X Administrative Console, open the Console and, in the Enter Logon Information dialog box, enter the credentials that you use to log on to your workstation.

   You are logged on to the Reflection X domain as the domain administrator. (The first user to log on to the Administrative Console is the default domain administrator.)

2. (Optional) To add a domain node, from the Domain Composition tab, under Domain Nodes, click +, then from the Add Domain Node dialog box, enter a descriptive name in the Friendly name field, and the computer name in the Host name field.
After the computer is added to the domain, the friendly name you entered is displayed in the **Registered Nodes** list.

Note: Under **Registration Details**, the **Participate in domain** setting is selected by default. This is required for domain participation. If you clear this setting, existing sessions can continue to run but new sessions won't be able to use this node.

3 Repeat step 2 for each computer you want to add to the domain.

4 Under **Domain Properties**, in the **Load balancing scheme** box, select the scheme used to balance the domain nodes.

<table>
<thead>
<tr>
<th>Select</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Round Robin</strong></td>
<td>Assign sessions to each domain node in order, and without priority.</td>
</tr>
<tr>
<td><strong>Optimize CPU</strong></td>
<td>Use available processing power to determine which domain node is selected for a session.</td>
</tr>
<tr>
<td><strong>Optimize memory</strong></td>
<td>Use available memory to determine which domain node is selected for a session.</td>
</tr>
</tbody>
</table>

5 (Optional) To change authentication systems, follow the instructions to set up a domain authentication.

Caution: Do not log off the domain without defining an administrative account. Without an administrative account, you cannot log on to the Administrative Console to manage your domain. (If you cannot log on because you do not have an administrative account, follow the instructions for unlocking a domain.)

---

### Set Up Domain Authentication

Reflection X Advantage supports the following authentication methods: Windows, PAM (Pluggable Authentication Modules), LDAP (Lightweight Directory Access Protocol), and Reflection X Internal.

The default Reflection X authentication method depends on the operating system of the computer on which you installed the domain controller. On a Windows computer, Windows authentication is used. On a UNIX or Mac computer, PAM authentication is used.
How Domain Access is Controlled

You can leverage your authentication process to provide Reflection X Advantage authentication. Reflection X Advantage supports the following authentication methods:

- **Windows**
  The default authentication system when the Reflection X domain controller is installed on a Windows system.

- **PAM (Pluggable Authentication Modules)**
  Available for several non-Windows operating systems. This is the default authentication system when the Reflection X domain controller is installed on a non-Windows system.

- **LDAP (Lightweight Directory Access Protocol)**
  A generic way of authenticating users that can be used with a number of directory servers that support LDAP. The configuration of LDAP authentication allows it to be used with different LDAP servers that have non-standard schema.

- **Reflection X Internal**
  A lightweight mechanism for authenticating users. The Reflection X administrator manually maintains a list of users.

The default Reflection X authentication method depends on the operating system of the computer on which you installed the domain controller. If it is installed on a Windows computer, Windows authentication is used. If it is installed on a non-Windows computer, PAM authentication is used.

You can set up your authentication system either to add users to the domain automatically when they log on, or to require that users must be added individually. (Requiring individual assignments allows you to provide access to only a subset of known users.)

---

Note: Automatically adding users is supported for all authentication methods except the Internal method.

---

Set Up LDAP Authentication

LDAP (Lightweight Directory Access Protocol) offers a generic way of authenticating users and can be used with a number of Directory Servers that support LDAP. The configuration of LDAP authentication allows it to be used with different LDAP servers that have non-standard schema.

**Before you Start**

- Add the computers that you have designated as domain components to the domain and configure the components.
Caution: Do not log off the domain without defining an administrative account. Without an administrative account, you cannot log on to the Administrative Console to manage your domain. (If you cannot log on because you do not have an administrative account, follow the instructions for unlocking a domain.)

To set up LDAP authentication

1. On the computer on which the Reflection X Administrative Console is installed, use the Administrative Console to log on to the domain.

2. From the Authentication tab, in the Authentication system list, select LDAP and then click Configure.

3. From the LDAP Configuration dialog box, enter the configuration data for your LDAP server.

4. After you change authentication methods, make sure the domain has an administrative account and password that you can use to log on to the domain.

5. Click Test Authentication to make sure the account is valid.

Set Up Reflection X Internal Authentication

The Internal authentication system is a lightweight mechanism for authenticating users.

Before you Start

- Add the computers that you have designated as domain components to the domain and configure the components.

To set up Reflection X Internal Authentication

1. On the computer on which the Reflection X Administrative Console is installed, use the Administrative Console to log on to the domain.

2. From the Administrative Console Authentication tab, in the Authentication system list, select Internal.

3. On the User Accounts list, click +, and then from the Add user to domain dialog box, enter a user name and password for your administrative account.
In the Administrator column, choose to provide administrative permissions for the account.

**Add or Remove Domain Users**

You can set up your Reflection X domain so that users are automatically added to the domain when they log on. (This is supported for all authentication systems except the Internal system.) If you want to have more control over access, you can set up the domain so that users must be added or removed individually.

**To allow access to all users in external authentication system**

- In the Reflection X Advantage Administrative Console, from the Authentication tab, select **Automatically create user account after successful logon**.

  All users who are in the authentication system are allowed access to the Reflection X domain. The first time a user logs on to the domain, his or her user account is added to the domain.

  Note: If you are using Reflection X Internal Authentication, you cannot automatically create accounts when users log on.

**To allow access to selected users only**

1. In the Reflection X Advantage Administrative Console, from the Authentication tab, clear **Automatically create user account after successful logon**.

2. To add a user, on the User Accounts list, click +, then, from the Add User to Domain dialog box, enter the user name and password (if you are using Internal authentication) you want to add.

3. To give the new user account administrative permissions, select the box in the Administrator column.

4. To remove a user, in the User Accounts list, select the user name to remove and click −.
Unlock a Domain

You can be locked out of a domain if you forget the administrator password, change authentication methods without adding an administrative account, or experience a problem with the external authentication system.

You can unlock the domain by running the recovery script.

To unlock a domain

1. On the server on which the Domain Controller is installed, from the Reflection X installation bin folder, run the script recover.exe (on Windows) or recovery (on non-Windows).

   Note: On some Windows systems running recover.exe will fail due to lack of permissions even if you are logged in with Administrative rights. To resolve this problem, right-click recover.exe and select "Run as administrator."

2. Restart the service.

3. Open the Administrative Console and log on to the domain with the following user name and password:
   
   **user name:** recovery
   
   **password:** recovery

   Note: Running the recovery tool allows access to the Administrative Console only once. After you log out, these login values for username and password won’t work again. To log in again with these values you need to repeat steps 1 and 2.

4. If you are using Internal authentication, create a new administrative account that you can use to log on to the domain.

5. (Optional) To change authentication systems, in the Authentication system list, select the authentication system to use.

6. Make sure the domain has an administrative account and password that you can use to log on to the domain, and then click Test Authentication to make sure that the account is valid.

   Caution: Do not log off from the domain without defining an administrative account. Without an administrative account, you cannot log on to the Administrative Console to manage your domain.
Deploy with Java Web Start

Use Java Web Start technology to deploy X Manager for Domains to user workstations from a Web server. This approach has the following advantages:

- The deployment process is simple — after the Web server is set up, users can run X Manager for Domains by opening a Web page and clicking a button.

- Deploying updates and configuration changes is easy, because configuration is centrally administered in one set of files on a Web server. When the user launches X Manager for Domains, Web Start determines whether updates are required, and installs them, if necessary.

- The same Web server and files support both Windows and UNIX environments.

Web Start deployments have the following limitations and requirements:

- Because Web Start cannot automatically start a service on a user workstation, it is not appropriate for installing Reflection X on computers that are intended to host permanent domains or function as domain nodes.

- A remote Reflection X domain must be set up on another computer (preferably one that runs continuously).

---

Note: Before you start, make sure that you:

- Install X Manager for Domains on your workstation.

- Set up a domain.

---

To deploy X Manager for Domains with Web Start

Configure your Web server so that all files with the extension .jnlp are set to the application/x-java-jnlp-file MIME type as follows:

- If you are using an Apache Web server, add the following line to the .mime.types configuration file (typically found in the .../conf/default folder):

  application/x-java-jnlp-file jnlp

- or -

- If you are using another type of Web server, consult your Web server documentation for instructions on adding MIME types.

1 Navigate to the folder in which you installed X Manager for Domains, and then from the Reflection X Advantage folder, copy the webstart folder (and all of its contents) to a folder on your Web server.
2  Change the name of the new folder on the Web server to rxwebstart.

3  Copy the images and help folders from the Reflection X Advantage folder to the rxwebstart folder on your Web server.

4  Copy all of the .jar files in the Reflection X Advantage\lib folder to the rxwebstart\lib folder on your Web server.

Note: There are two lib folders in the installation folder: the Reflection X Advantage\webstart\lib folder and the Reflection X Advantage\lib folder.

5  In the Web server folder rxwebstart, edit the following files as noted:

<table>
<thead>
<tr>
<th>In this file</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>jsafe.jnlp</td>
<td>Set the codebase attribute to reference the rxwebstart folder on your Web server:</td>
</tr>
<tr>
<td></td>
<td>&lt;jnlp spec=&quot;6.0+&quot; codebase=&quot;http://localhost/rxwebstart&quot; href=&quot;jsafe.jnlp&quot;&gt;</td>
</tr>
<tr>
<td>atmXManager.jnlp</td>
<td>Move the following two lines outside the commented block in which they reside by default:</td>
</tr>
<tr>
<td></td>
<td>&lt;argument&gt;-domain&lt;/argument&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;argument&gt;domainComputerName&lt;/argument&gt;</td>
</tr>
<tr>
<td></td>
<td>Edit the domain name argument (domainComputerName) to specify the network name of the computer running your domain controller.</td>
</tr>
<tr>
<td></td>
<td>Set the following codebase attribute to reference the Webstart folder on your Web server:</td>
</tr>
<tr>
<td></td>
<td>&lt;jnlp spec=&quot;6.0+&quot; codebase=&quot;http://localhost/rxwebstart&quot; href=&quot;atmXManager.jnlp&quot;&gt;</td>
</tr>
<tr>
<td>jogl.jnlp</td>
<td>Change localhost in the following line to your host name.</td>
</tr>
<tr>
<td></td>
<td>&lt;jnlp codebase=&quot;http://localhost/rxwebstart/&quot; href=&quot;atmXManager.jnlp&quot; &gt;</td>
</tr>
<tr>
<td>gluegen-rt.jnlp</td>
<td>Change localhost in the following line to your host name.</td>
</tr>
<tr>
<td></td>
<td>&lt;jnlp codebase=&quot;http://localhost/rxwebstart/&quot; href=&quot;gluegen-rt.jnlp&quot;&gt;</td>
</tr>
</tbody>
</table>

6  (Optional) Edit the file atmXManager.jnlp to specify user name, password, and other configurable options. By defining these options, you can set up a Web Start link that automatically logs the user on to a domain and launches a session. Instructions are included in the atmXManager.jnlp file.

7  In a Web browser, navigate to the URLs you assigned to the variables codebase and href, and make sure that the files rxadvantage.jar and atmXManager.jnlp are accessible.
8 Distribute to users the link to the StartReflectionX.html page.

Notes:

- Web browsers, when determining how to handle content returned from the Web server, typically use the MIME type. To open Web Start, the server must return the following MIME type for .jnlp files:

  application/x-java-jnlp-file

- Java Web Start is an application launcher for Java applications that are written for Web deployment. Java Web Start caches resources locally on the disk, but also provides a secure execution environment and virtually transparent updating facility for applications. It is not necessary for the end user to initiate a software update manually, because the application is updated each time it is used.
Deploying to Windows Workstations

In this Chapter

- Performing a Basic Deployment 74
- Performing an Advanced Deployment 74
- Create an Administrative Installation Point 75
- Attachmate Customization Tool 76
- Creating and Editing Transforms 78
- Creating a Companion Install Package 83
- Deploying Reflection X 86

You can choose from several different approaches for installing and deploying Reflection X. Deciding which approach to use is typically based on a variety of factors, including your approved business processes, the scale of the deployment, your deployment tools, and whether you want to customize the installation.

For example, a small-scale deployment might consist of using the Attachmate Setup to install Reflection X on a few workstations, whereas an enterprise-wide deployment would probably involve extensive customization and testing.

Use one of the following approaches, depending on your requirements.

- **Perform a Workstation Installation on each Workstation**
  Install all of the files for Reflection X to a PC hard drive. You might choose this approach if you are installing Reflection X on a small number of machines and you do not need to customize the installation.

- **Perform a Basic Deployment**
  Perform an administrative installation to copy Reflection X files to an administrative installation point. This is also referred to as creating an administrative installation image. Then, using deployment tools, you access these files and create packages that are deployed to workstations. A basic deployment is a good choice when you need to deploy Reflection X to a large number of workstations but you do not need to customize the installation.
Perform a Customized Deployment
Perform an administrative installation to copy Reflection X files to an administrative installation point (just as you would for a basic deployment). Then, you customize the installation to specify the way it installs, looks, and acts on the end users' computers. Customized deployments can be used to deploy to any number of workstations.

Performing a Basic Deployment
Perform a basic deployment when you need to install the default (uncustomized) Reflection X application on a large number of machines.

The following process is typical for a large-scale, basic deployment:
1. *Perform an administrative installation* (page 75) in a destination folder to create an administrative installation point.
2. Test the installation.
3. Deploy Reflection X from the administrative installation point. Because the installation package adheres to MSI standards, you can use Microsoft Active Directory, Microsoft Systems Management Server, or any other Microsoft Installer-compatible deployment tool.

Performing an Advanced Deployment
Perform an advanced deployment when you need to customize your installation to:
- Limit an end user's access to application features
- Customize the installation of the Reflection X files
- Create companion installation packages of custom files that can be installed independently from the main installation.

The following process is typical for large-scale, customized deployments.
1. *Perform an administrative installation* (page 75) in a destination folder to create an administrative installation point.
2. From the administrative installation point, do one of the following:
   - *Create standard MSI transforms* (page 78) to modify the primary installer database.
     You can specify the install location, set feature states, modify or remove shortcuts, remove older products, and chain other installs or programs.
   - or -
• *Create companion install packages* (page 83) that include the custom files you created on the workstation.

You can install these separate MSI packages independently of the Reflection X install. This allows you to upgrade the product without removing these custom files. It also allows you to install or remove the custom files without installing or removing the main Reflection X files.

3. Test the installation.

4. Deploy Reflection X with the transforms you created, as well as any separate MSI packages.

Because the transforms and companion installation packages adhere to MSI standards, you can use a desktop shortcut, Microsoft Active Directory, Microsoft Systems Management Server, or any other Microsoft Installer-compatible deployment tool.

---

**Create an Administrative Installation Point**

To prepare your environment for deployment, you will need to create an administrative installation point. You do this by installing an administrative install image of Reflection X on a network share (typically on a file server). An administrative install image is a source image of the application, similar to an image on a CD-ROM. It includes all the files required to install Reflection X as well as the administrative tools used for customization.

| Caution: For this procedure, use only the Advanced and File Location tabs. Configurations made from other tabs will be ignored. |

---

Notes:

- Attachmate’s recommended practice is to create an administrative installation point before you install Reflection X on a workstation. This allows you to use the administrative installation point for the workstation installation.

- If you prefer to use a command line instead of the Attachmate Installation Program graphical interface, you can create an administrative install image from the command line as follows:

```
path_to_setup_file\Setup.exe /install /admin
TARGETDIR=UNC_path_to_administrative_installation_point
```

- If you prefer to install Reflection X on your workstation first, you must create the administrative install image from the command line as follows:

```
path_to_setup_file_on_your_workstation\Setup.exe /install /admin
TARGETDIR=UNC_path_to_administrative_installation_point
```
To create an administrative install point

1. Create a network share on a network file server.

2. Click the download link, and then run the download program. Select a location for the installer files, and then click Next.

   This extracts the files to the specified location and starts the Attachmate Installation Program. (If you have already downloaded the files, click the setup.exe file to start the installation program.)

3. Click Continue and accept the license.

4. From the Advanced tab, click Create an Administrative install image on a server.

5. Click Continue, and then browse to the network share you want to use for the administrative install image.

   Important! Be sure to specify the path to the network share as a UNC path (for example: \share_name\administrative_install_point).

6. Click Install Now.

   Note: Administrative installation images are typically created in a file server folder. However, you can create administrative installation images in any folder on a local hard disk, which can be useful for testing purposes.

Attachmate Customization Tool

The Attachmate Customization Tool is a special mode of the Attachmate Setup that supports custom modifications to the primary install and includes some limited deployment facilities. These are accomplished with a simple user interface, and do not require additional software packages or training.

Use the Attachmate Customization Tool to create transforms or companion installer packages. Each type of customization has its own set of configuration panels that display, depending on your choice from the Select Customization panel.

Open the Attachmate Customization Tool

You must first create an administrative install image before you can run the Attachmate Customization Tool.
To open Attachmate Customization Tool

Do one of the following:

- On a command line, change to the administrative installation point and enter:
  ```
  setup /admin
  ```
  Or

- If you have set up a shortcut to ACT (page 77), double click the shortcut.

The Select Customization dialog box prompts you to choose which mode you want to open.

---

**Note:** You cannot run the Attachmate Customization Tool if you are currently running the Attachmate Setup; you can run only one instance of the `setup.exe` program at a time.

---

Set up a shortcut to ACT

By default, the Attachmate Customization Tool (ACT) can be opened only from a command line but you can create a desktop shortcut and set the shortcut properties to open this tool. Although creating this shortcut is optional, you will find that it saves time when you are working with ACT.

To set up a desktop shortcut that opens ACT

1. On your administrative installation point, right-click on the `setup.exe` file and choose Create Shortcut.

2. Right-click on the shortcut and choose Properties.

3. In the Target field, add the `/admin` option to the end of the command line. For example:
   ```
   \myServer\adminInstallPoint\setup.exe /admin
   ```

   **CAUTION:** Make sure the path in the Target field is referenced with a Uniform Naming Convention (UNC) format. Do not use drive letters in the path name. Using drive letters can cause problems when you try to use the shortcut on other workstations.

4. Rename the shortcut and save it on the desktops of your workstation and on the server that you are using for your administrative installation point.
Select a Customization Type

Once you've opened the Attachmate Customization Tool, you can create a transform, a companion install package, or open an existing file of either type.

To select a customization type

1. From the **Select Customization** dialog box, select a customization type:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new transform file (.mst)</td>
<td>Create a new Setup customization file for the following product (the default).</td>
</tr>
<tr>
<td>Create a new companion install package (.msi)</td>
<td>Create a new Companion installer.</td>
</tr>
<tr>
<td>Open an existing file of either type</td>
<td>Open an existing Setup customization file or Companion installer.</td>
</tr>
</tbody>
</table>

2. Click **OK**.

Creating and Editing Transforms

Using the Attachmate Customization Tool, you can create standard MSI transforms that modify the primary installer database. You can also open and edit existing .mst files that you have already created for this product using the Attachmate Customization Tool.

After you create the transform, you must include it in the install. Transforms can be used with any install started with setup.exe or with command-line installs (used by many deployment tools). The installer can only apply transforms during an installation.

Notes:

- To use a transform file with setup.exe, from the **User interface** panel, select **Use this customization with interactive installs using setup.exe**. When you save your transform with this option selected, Attachmate Customization Tool automatically updates the SETUP.INI file to apply your transform to the Reflection X installation.

- To install the specified customization, you should save transform files in the same folder as the package file for Reflection X, and reference them during installation.

- For more information about creating and deploying transforms, see Technical Note 2369 (http://support.attachmate.com/techdocs/2369.html).
Supported modifications include:

- Install location
- User interface level — silent or interactive (requires `setup.exe` and `setup.ini`)
- Feature states, including hidden features
- Modification or removal of shortcuts
- Optional upgrades of older products
- Chaining of other installs, or execution of programs before or after the primary install (requires `setup.exe` and `setup.ini`)
- Modifying Windows Installer properties

**Create Transforms**

Customize Reflection X to specify the way you want it to install, look, and act on the end user's computer.

**To create an installation transform**

1. From a command line, open the Attachmate Customization Tool:
   
   ```
   path_to_setup\setup.exe /admin
   ```

2. Select Create a new setup customization file for the following product, and then click **OK**.

3. Select items from the list in the left panel to open configuration panels on the right, and then make your customizations.

4. From the **File** menu, choose **Save As**.
   
   Transform files are saved as `.mst` files, and it is recommended that you save them in the same folder as the installer package file for Reflection X.

**To modify an existing installation transform**

1. From a command line, open the Attachmate Customization Tool:
   
   ```
   path_to_setup\setup.exe /admin
   ```

2. Select Open an existing Setup customization file or Companion installer, and then click **OK**.

3. In the **Open** dialog box, browse to the location you selected when you created your transform file, and select the `transform_name.mst` file.

4. Select items from the list in the left panel to open configuration panels on the right, and then make your customizations.
5 From the **File** menu, choose **Save As**.

Transform files are saved as `.mst` files, and it is recommended that you save them in the same folder as the installer package file for Reflection X.

### Add (Chain) Installations and Run Programs

Reflection X makes it easy to "chain" installs. You can set up an install to run companion install packages automatically before or after the primary installation. You can also specify to run other scripts or programs.

**To chain installations and programs**

1. From a command line, open the Attachmate Customization Tool:

   `path_to_setup\setup.exe /admin`

2. Select **Create a new setup customization file for the following product**, and then click **OK**.

3. From the Attachmate Customization Tool navigation pane, choose **Add installations and run programs**.

4. Click **Add**.

   The **Add/Modify Program Entry** dialog box opens.

5. In the **Target** list, enter or select the folder where the program `.exe` file or the `.msi` file resides, and then enter the executable to run; for example:

   `msiexec.exe`

6. Under **Arguments**, enter the command-line arguments to execute; for example:

   `/i my_installation.msi`

7. To specify when to run the program, select either **Run this program after base product has been installed**, or **Run this program before the base product has been installed**.

   Note: For most cases, select **Run this program after the base product has been installed**. If you select **Run this program before the base product has been installed** and the program fails, Reflection X is not installed.

8. Repeat these steps to add other programs or MSI files.

9. To change the execution sequence, use the arrows next to **Move** (at the bottom left area of the pane); to remove a program from the list, select it in the list and click **Remove**.
Select Features, Components, and Languages

You can select which features, components, and languages to install for your end users. In addition, you can choose from three levels of not installing an item: advertising it, not installing it, and permanently blocking it to prevent users from installing it later.

**To select features, components, and languages to install**

1. From a command line, open the Attachmate Customization Tool:
   ```
   path_to_setup\setup.exe /admin
   ```
2. Select **Create a new setup customization file for the following product**, and then click **OK**.
3. From the Attachmate Customization Tool navigation pane, choose **Set Feature Installation States**.
4. Select the feature installation states as follows:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Feature will be installed on local hard drive" /></td>
<td>Add a feature to the installation.</td>
</tr>
<tr>
<td><img src="image" alt="Feature will be installed when required" /></td>
<td>Advertise a feature.</td>
</tr>
<tr>
<td><img src="image" alt="Feature will be unavailable" /></td>
<td>Leave a feature uninstalled. End users will still be able to select the item and install it from the Windows <em>Uninstall or change a program</em> list (or the <em>Add/Remove Programs</em> control panel in Windows XP).</td>
</tr>
<tr>
<td><img src="image" alt="Feature will be hidden from view" /></td>
<td>Leave a feature uninstalled and hidden. End users will not be able to install the item and it will not be visible in the Windows <em>Uninstall or change a program</em> list.</td>
</tr>
</tbody>
</table>
Configure Shortcuts

You can change the attributes associated with the pre-defined Reflection X shortcuts. Also, you can configure shortcuts associated with files you've added to a custom install package.

To configure shortcuts

1. From a command line, open the Attachmate Customization Tool:
   ```
   path_to_setup\setup.exe /admin
   ```
2. From the Select Customization dialog box, select the option that best describes the task you are performing.
3. From the Attachmate Customization Tool navigation pane, choose Configure shortcuts.
4. Select the shortcut that you want to configure, and then click Modify.
5. In the Modify Shortcut dialog box, enter the following settings:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify where you want the shortcut to reside</td>
<td>In the Location list, enter or select the folder. Note: List items that refer to folders (for example, [ProgramMenuFolder]) are pre-defined folder keywords. You can create customized directories by adding new folder names with typical directory syntax (such as, [ProgramFilesFolder]\My Folder). Alternatively, you can enter a fully qualified path (for example, C:\Program Files\My Folder), as long as that location is known to exist on the target machine.</td>
</tr>
<tr>
<td>Name the shortcut</td>
<td>In the Name box, enter a descriptive name.</td>
</tr>
<tr>
<td>Add a tooltip to the shortcut</td>
<td>In the Tooltip box, enter descriptive text to describe the shortcut.</td>
</tr>
<tr>
<td>Pass command line arguments to the program</td>
<td>In the Arguments box, enter the command-line arguments.</td>
</tr>
<tr>
<td>Specify the size of the application window</td>
<td>In the Run list, select an initial size for the application window.</td>
</tr>
</tbody>
</table>
Creating a Companion Install Package

Create a companion install package (also called a "companion database") to install any files that are not installed with Reflection X.

Because companion files are installed independently of Reflection X, you can upgrade the product without removing these support files. You can also deploy additional support files without re-installing the product. If, for example, you are supporting several business units that require their own customized configuration files, you can create a companion install package for each business unit.

Companion install packages support:

- Specification of files and installation directories.
- Shortcuts for selected files.
- Addition of custom application settings.
- Chaining with the primary installer (chaining must be specified in the .mst file).
- Removal without affecting the primary installs. (The primary install can also be removed without affecting the files added with a companion package.)

Companion install packages can be installed with any mechanism that supports MSI packages. The packages have no built-in user interface, other than the standard progress bar.

Create a Companion Install Package

Create a companion install package (also called a "companion database") to install any files that are not installed with Reflection X.

**To create a companion install package**

1. From a command line, open the Attachmate Customization Tool:

   `path_to_setup\setup.exe /admin`

2. From the Select Customization dialog box, select Create a new Companion installer (or open an existing MSI), and then click OK.

3. From the navigation pane, select Specify package information.
4 In the **Add/Remove name** box and the **Organization name** box, type a name for the installation and the publisher that you want to be displayed in the Microsoft Windows "Uninstall or change a program" panel.

---

**Note:** The Windows Vista and Windows 7 *Uninstall or change a program* list is similar to the Windows Add or Remove Programs List for previous versions of Windows. It is accessed by selecting Programs and Features from the Control Panel.

5 From the navigation pane, select **Specify install locations**.

6 Under **Installation type**, select whether to install the files for all users or for only one user:

<table>
<thead>
<tr>
<th>Select</th>
<th>To set up the companion installer package to</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installs to all users of a machine</strong></td>
<td>Make files available for every user who logs onto the computer.</td>
</tr>
<tr>
<td></td>
<td>Use this option for settings files, macros, and other configuration files that you want to be available to all users.</td>
</tr>
<tr>
<td><strong>Installs only for the user who installs it</strong></td>
<td>Make files available only for the user who installs it.</td>
</tr>
</tbody>
</table>

**Important!** If you are deploying files that must be installed in the user’s personal data folders, you must select this option.

7 In the **Default installation folder** list, select the folder in which to install the files. (Files are deployed to this folder unless you specify another folder when you add a file.)

---

**Note:** The folders available in this list depend on which Installation type you chose. **Installation Type** folder options specify the access for the files (after the installation). These options affect only the folders to which you can install — you cannot change these options after you add a file.

8 In the **Default shortcut folder** list, select the folder in which to install program shortcuts. (Shortcuts are deployed to this folder unless you specify another folder when you add a file.)

---

**Note:** List items that refer to folders (for example, `[ProgramMenuFolder]`) are pre-defined folder keywords. You can create customized directories by adding new folder names with typical directory syntax (such as, `[ProgramFilesFolder]\My Folder`). Alternatively, you can enter a fully qualified path (for example, `C:\Program Files\My Folder`), as long as that location is known to exist on the target machine.

**Note:** **Installation type** options specify the access for the files (after the installation). These options affect only the folders to which you can install — you cannot change these options after you add a file.
Chapter 7 Deploying to Windows Workstations

From the navigation pane, select **Add files** to add, update, or remove files or shortcuts.

You can also modify setup properties or user settings for the companion installation.

When you have finished creating your companion package, you can deploy it by itself or with Reflection X. The package remains on the end user's computer until it is removed with the Microsoft Add/Remove Programs utility.

### Add Files to a Companion Installer

You can add or remove files and shortcuts to or from a companion install package.

**To add a file to the companion installer**

1. From a command line, open the Attachmate Customization Tool: 
   
   ```
   path_to_setup\setup.exe /admin
   ```

2. From the **Select Customization** dialog box, select **Create a new Companion installer** (or open an existing MSI), and then click **OK**.

3. From the navigation pane, select **Specify install locations**.

4. Under **Installation type**, specify either **Installs to all users of a machine** or **Installs only for the user who installs it**.

5. From the navigation pane, select **Add files**.

6. Under **Add files to**, specify a destination location for the file. You can choose a location from the list or edit the path by typing.

7. (Optional) To create a shortcut for the file, select **Include shortcut**.

8. Click **Add**, browse to locate the file you want to add to the installation, and then click **Open**.

### Add a Companion Installer to your Installation

You can use this procedure to add one or more custom installer packages to your product installation.

**To add a companion package to your installation**

1. From a command line, open the Attachmate Customization Tool:
    
    ```
    path_to_setup\setup.exe /admin
    ```

2. Select **Create a new setup customization file for the following product**, and then click **OK**.

3. From the navigation pane, click **Add installation and run programs**.
4 Click **Add**.

The **Add/Modify Program Entry** dialog box opens.

5 In the **Target** list, browse to select your companion `.msi` file.

6 Select **Run this program after the base product has been installed**.

7 Click **OK**.

8 Click **File > Save As** to save your transform.

---

**Note:** When you save your transform, the Customization Tool automatically updates the `Setup.ini` file, adding a `[RunPrograms]` section with instructions for installing your companion package.

9 Instruct users to install using `Setup.exe`.

The companion package is automatically installed after the installation is complete.

### Deploying Reflection X

For Windows systems, you can perform an administrative installation and use the following methods to deploy Reflection X:

- **Perform a silent installation from the command line** (page 86)
- **Assign and publish with Active Directory** (page 87)
- **Deploy with Systems Management Server** (page 87)

For both Windows and UNIX systems, you can deploy with Java Web Start.

### Perform a Silent Installation from the Command Line

A silent installation proceeds without the end user being able to intervene or, in some cases, even see that the installation is occurring.

**To perform a silent installation**

- At a command prompt or the Start menu Run command, change to the directory in which the `setup.exe` file resides and do one of the following:

<table>
<thead>
<tr>
<th>To perform</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A silent install that displays a progress bar and disables the <strong>Cancel</strong> button</td>
<td><code>setup.exe /install /passive</code></td>
</tr>
<tr>
<td>A silent install with no display</td>
<td><code>setup.exe /install /quiet</code></td>
</tr>
</tbody>
</table>
Assign and Publish with Active Directory

You can assign and publish your product installation using Microsoft Active Directory.

Note: Before you start, make sure that:

- Windows Administrative Tools are installed on your workstation.
- You are a member of Domain Admins and Group Policy Creators and Owners (required to publish software).

For more information, see "Active Directory groups" in the Microsoft Management Console help.

To install with Active Directory

1. From the **Active Directory User and Computers Console**, advertise your product installation to members of any organizational units in your Active Directory using appropriate transform modifications.

2. If multiple transforms are specified, make sure the listed order of the transforms is correct, and then click **OK**. (If you need to change the order for any reason after you click **OK**, you will have to start over again.)

Note: For more information about assigning and publishing, see "assigning applications" and "publishing applications" in the Microsoft Management Console help.

Deploy with Systems Management Server

You can deploy Reflection X with Microsoft Systems Center Configuration Manager (or Microsoft Systems Management Server).

Note: Before you start, make sure that:

- You are using SMS version 1.2 or later (SMS versions earlier than 1.2 are not supported).
- Microsoft Windows Installer software version 2.0 or later is installed on your computer, and on all of the computers on which you are installing the product.
To deploy with System Center Configuration Manager

1. Create an administrative install image on your site server.
   This serves as the administrative installation point for deployment.

2. Use the product Package Definition File (*.sms) to create the product installation package.

   Note: The Package Definition File (*.sms) is created during the administrative installation and can be found at the root of the administrative installation point. Alternatively, you can reference the .msi file directly — consult the Microsoft SMS documentation for more information.

3. Advertise the installation packages to your users.
CHAPTER 8

Using PKI Services Manager with Reflection X

In this Chapter

Setting up PKI Services Manager on Windows 90
Setting up PKI Services Manager on UNIX 94
Configure Reflection X to Connect to PKI Services Manager 98

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge.

- Reflection PKI Services Manager is required for Secure Shell connections that use certificates for host authentication. (It is not required for user authentication with certificates.)

- Reflection PKI Services Manager is supported on both Windows and UNIX platforms.

- Reflection PKI Services Manager supports central management of PKI settings. You can install and configure a single instance of PKI Services Manager to provide certificate validation services for all supported Attachmate products. (Because Reflection X settings allow only one entry for the PKI Services Manager address and port, this configuration creates a potential single point of failure. If PKI Services Manager is unreachable or the server is not running, all authentication attempts using certificates will fail. In order to provide load balancing and failover, you can define a round-robin DNS entry for the PKI Services Manager host name or place the PKI Services Manager host behind a load balancing server.)

- You can run Reflection PKI Services Manager on the same host as a Reflection X domain controller or on a different host.

This user guide provides basic information about installing PKI Services Manager and configuring Reflection X to use it for certificate validation services. For additional information, refer to the PKI Services Manager documentation at http://support.attachmate.com/manuals/pki.html.
How it Works

1. The X client host presents a certificate to Reflection X Advantage for host authentication.

2. Reflection X connects to Reflection PKI Services Manager and verifies its identity using an installed public key.

3. Reflection X sends the certificate and host name to PKI Services Manager.

4. PKI Services Manager determines if the certificate is valid and uses mapping rules to determine whether the host is allowed to authenticate with this certificate.

5. If the certificate is valid and the host presenting it is an allowed identity for this certificate, Reflection X validates the host's digital signature. If the digital signature is verified, host authentication is successful.

Setting up PKI Services Manager on Windows

Install and Uninstall PKI Services Manager on Windows

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge. Use this procedure to install Reflection PKI Services Manager on Windows systems.

Note: Reflection PKI Services Manager supports central management of PKI settings. You can install and configure a single instance of PKI Services Manager to provide certificate validation services for all supported Attachmate products.

To install Reflection PKI Services Manager

1. Log in as an administrator.

2. Download the Reflection PKI Services Manager installer package.
3 Run the Setup program.

Note: To install the service, accept the default settings on the Advanced tab. Creating an administrative installation image does not actually install the product — instead, it places the install files on a network location for later installation to multiple workstations.

4 Start the service (page 83).

Notes:

- On Windows, starting the console or the service for the first time initializes PKI Services Manager. This creates the required data folders and default settings files. If these folders already exist, they are not changed; PKI Services Manager uses your existing data files and folders. (On UNIX the install script automatically initializes PKI Services Manager if required, and starts the service.)

- Before Reflection PKI Services Manager can validate certificates you need to edit the default configuration and map files.

To uninstall Reflection PKI Services Manager

1 Log in as an administrator.

2 From the Windows Programs and Features (or the Add or Remove Programs) control panel, select Attachmate Reflection PKI Services Manager.

3 Click Uninstall (or Remove).

Configure PKI Services Manager on Windows

To configure client host authentication using certificates, you need to install and configure Reflection PKI Services Manager. Use the following procedure to get started. Many variations are possible. For more information about each of the steps below, see the Reflection PKI Services Manager User Guide, which is available from the PKI Services Manager console, and from http://support.attachmate.com/manuals/pki.html.

Before you begin:

- Install PKI Services Manager (page 90).

- Determine which trusted CA certificate and intermediate certificates are needed to validate the certificate that will be presented by the host you are connecting to. PKI Services Manager can use certificate files that you copy to your system, or trusted root certificates installed to the Windows certificate store for use by the local computer.
• Determine how certificate revocation checking should be handled for the host certificate. You can configure PKI Services Manager to use CRL lists, OCSP responders, or to contact a CRL distribution point specified within the certificate.

To configure PKI Services Manager

1. Log in as an administrator on the computer running PKI Services Manager.

2. Start the PKI Services Manager console:

   Programs > Attachmate Reflection > Utilities > PKI Manager

3. Put a copy of the certificate you want to designate as a trust anchor into your local store. The default PKI Services Manager store is in the following location:

   `common application data folder\Attachmate\ReflectionPKI\local-store`

   (This step is not required if you are using certificates in the Windows store or you have a copy of the trust anchor available somewhere else on your system.)

4. From the **Trusted Chain** pane, add your trust anchor (or anchors) to the list of trust anchors.

<table>
<thead>
<tr>
<th><strong>To use this store</strong></th>
<th><strong>Do this</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Your local certificate store or a certificate file on your system</td>
<td>Click <strong>Add</strong>. Select either <strong>Local store certificate</strong> or <strong>Certificate file</strong>, click <strong>Browse</strong> and select the certificate for your trust anchor.</td>
</tr>
</tbody>
</table>

   The Windows certificate store

   Under **Search order to use when building path to trust anchor**, select "Windows certificate store."

   Click **Add**.

   From the Add Trust Anchor dialog box, select **Windows certificate** then click **Browse** to select an available certificate.

   **Note:** PKI Services Manager uses only those certificates that are installed for use by the local computer (not certificates installed for the current user) and are in either the trusted root certification authorities list or the trusted intermediate authorities list. To view and manage the local computer certificates, use the Microsoft Management Console. Add the Certificates Snap-in and configure it to manage certificates for the computer account.
6. From the **Revocation** pane, configure certificate revocation checking.

   **Note:** By default PKI Services Manager looks for CRLs in the local store. If you use this configuration, you need to copy the CRLs to your local store.

7. From the **Identity Mapper** pane, click **Add** to determine which client hosts can authenticate with a valid certificate.

   For example, to allow client hosts to connect if the host name is specified in the Common Name value of the certificate's Subject field:

   - Set **Select type of certificate that is to be mapped** to Host Certificate
   - Click the drop-down arrow for **Choose certificate identity to insert** and select Subject Common Name.

   Refer to the PKI Services Manager documentation for additional information about mapping rules.

8. Click **File > Save**.

9. **Start the PKI Services Manager service** (page 93) if it isn't already running. If the service is already running, reload your settings (**Server > Reload**).

### Start and Stop the PKI Services Manager Service on Windows

The PKI Services Manager service starts automatically when you restart Windows. A command line utility (**winpki**) is installed, which you can use to start, stop, restart, and check the status of the service. You can also start and stop the service using the Windows Services console.

**To start the service**

- Restart Windows.
  - or -

- From a DOS command window, enter the following command:
  
  ```
  winpki start
  ```
  
  - or -

- Open the Windows Services console (Control Panel > Administrative Tools > Services), select Attachmate Reflection PKI Services Manager and click Start.
To stop the service

- From a DOS command window, enter the following command:
  
  ```
  winpki stop
  ```
  
  -or-

- Open the Windows Services console (Control Panel > Administrative Tools > Services), select Attachmate Reflection PKI Services Manager and click Stop.

To check the service status

- Start the PKI Services Manager console and look for status information on the status line at the bottom of the console window.
  
  -or-

- From a DOS command window, enter the following command:
  
  ```
  winpki ping
  ```
  
  -or-

- Open the Windows Services console (Control Panel > Administrative Tools > Services) and view the status of Attachmate Reflection PKI Services Manager.

Setting up PKI Services Manager on UNIX

Install and Uninstall Reflection PKI Services Manager on UNIX

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge. Use this procedure to install Reflection PKI Services Manager on UNIX systems.

To install Reflection PKI Services Manager

1 Log in as root.

2 Copy the installation package file to your computer and navigate to the directory that contains this file.

3 Use gzip to unzip the package:

  ```
  gzip -d package_name.tar.gz
  ```
  
  For example:

  ```
  gzip -d pkid_1.0.0.999-i386-solaris.gz
  ```
4 Use tar to expand the file:

    tar -xf package_name.tar

This creates a directory based on the package name. For example:

    pkid_1.0.0.999--i386-solaris/

5 Change to this directory. For example:

    cd pkid_1.0.0.999-i386-solaris

6 Run the install script:

    ./install.sh

7 You are prompted to specify installation locations. To accept the default locations (recommended), press Enter in response to these prompts.

Notes:

- On UNIX the install script automatically starts the service.
- Before Reflection PKI Services Manager can validate certificates you need to edit the default configuration and map files.

To uninstall

1 Log in as root.

2 Run the uninstall script. This script is installed to the bin directory in the PKI Services Manager data folder. The default path is:

    /opt/attachmate/pkid/bin/uninstall.sh

Note: The uninstall script renames your existing configuration directory (/opt/attachmate/pkid/config/ by default) using a name based on the current date, and time. For example, config.20100101143755. Your local-store directory and any certificates you have added to this directory remain unchanged.
Configure PKI Services Manager on UNIX

To configure client host authentication using certificates, you need to install and configure Reflection PKI Services Manager. Use the following procedure to get started. Many variations are possible. For more information about each of the steps below, see the Reflection PKI Services Manager User Guide, which is available from the PKI Services Manager console, and from http://support.attachmate.com/manuals/pki.html.

Before you begin:

- **Install PKI Services Manager** (page 94).
- Obtain the trusted CA certificate and any intermediate certificates that are needed to validate the certificate that will be presented by the host you are connecting to.
- Determine how certificate revocation checking should be handled for the host certificate. You can configure PKI Services Manager to use CRL lists, OCSP responders, or to contact a CRL distribution point specified within the certificate.

**To configure PKI Services Manager**

1. Log in as root on the Reflection PKI Services Manager server.
2. Install Reflection PKI Services Manager.
3. Put a copy of the certificate you want to designate as a trust anchor into your local store. The default PKI Services Manager store is in the following location:
   `/opt/attachmate/pkid/local-store`
4. Open the PKI Services Manager configuration file in a text editor. The default name and location is:
   `/opt/attachmate/pkid/config/pki_config`
5. Use the `TrustAnchor` keyword to identify your trust anchor. For example:
   ```
   TrustAnchor = trustedca.crt
   -or-
   TrustAnchor = CN=SecureCA,O=Acme,C=US
   ```

**Note:** To configure multiple trust anchors, add additional `TrustAnchor` lines.
Configure certificate revocation checking. For example:

<table>
<thead>
<tr>
<th>To</th>
<th>Sample Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use CRLs stored on an LDAP server.</td>
<td>RevocationCheckOrder = crlserver</td>
</tr>
<tr>
<td></td>
<td>CRLServers=ldap://crlserver</td>
</tr>
<tr>
<td>Use an OCSP responder.</td>
<td>RevocationCheckOrder = ocsp</td>
</tr>
<tr>
<td></td>
<td>OCSPResponders = <a href="http://ocsresponder">http://ocsresponder</a></td>
</tr>
</tbody>
</table>

Note: By default PKI Services Manager looks for CRLs in the local store. If you use this configuration, you need to copy the CRLs to your local store.

If intermediate certificates are required by the chain of trust in your certificates, configure access to these certificates. For example:

<table>
<thead>
<tr>
<th>To</th>
<th>Sample Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use intermediate certificates you have added to your local store.</td>
<td>CertSearchOrder=local</td>
</tr>
<tr>
<td>Use certificates stored on an LDAP server.</td>
<td>CertSearchOrder=certserver</td>
</tr>
<tr>
<td></td>
<td>CertServers=ldap://ldapserver</td>
</tr>
</tbody>
</table>

Save your changes to the configuration file.

Open the PKI Services Manager map file in a text editor. The default name and location is:

```
/opt/attachmate/pkid/config/pki_mapfile
```

Add one or more rules to determine which client hosts can authenticate with a valid certificate. For example, to allow client hosts to connect if the host name is specified in the Common Name value of the certificate's Subject field:

```
RuleType = host
{acme.com}
```

Test for valid PKI Services Manager configuration:

```
/usr/local/sbin/pkid -k
```

No errors. Configuration is valid:

Restart Reflection PKI Services Manager.

```
/usr/local/sbin/pkid restart
```
Start and Stop the Service on UNIX

The PKI Services Manager service starts automatically after installation. A script is installed, which you can use to start, stop, restart, and check the status of the service.

Note: The following procedures use the installed `pkid` script (`/etc/init.d/pkid`). For additional options available using the `pkid` daemon (`/usr/local/sbin/pkid`), see PKI Services Manager Command Reference or refer to the manual page: `man pkid`

To start the service

```
/etc/init.d/pkid start
```

To stop the service

```
/etc/init.d/pkid stop
```

To check the service status

```
/etc/init.d/pkid status
```

Configure Reflection X to Connect to PKI Services Manager

Reflection X needs to connect to Reflection PKI Services Manager for host certificate verification. The procedure for configuring this connection depends on whether you are running in standalone or domain mode.

- In standalone mode, use X Manager to configure the connection to PKI Services Manager. This connection must be configured individually on each computer running X Manager.

- In domain mode, you need to use the Administrative Console to configure the connection to PKI Services Manager. This enables you to configure the connection once for all domain users. The connection information is used for all Secure Shell client connections in the domain that require host certificate authentication.
Before you begin:

On the host running PKI Services Manager, locate the PKI Services Manager public key. To complete this procedure, you need to be able to access this key.

The default location on Windows is:
common application data
folder\Attachmate\ReflectionPKI\config\pki_key.pub

The default location on UNIX is:
/opt/attachmate/pkid/config/pki_key.pub

**To configure X Manager to connect to PKI Services Manager**

1. Start X Manager.
2. From the **Tools** menu, click **Secure Shell Host keys**.
3. Click the **PKI Configuration** tab.
4. For **PKI server**, specify the host name or IP address of the computer running PKI Services Manager. (You can specify *localhost* if you're running X Manager and PKI Services Manager on the same computer.)

   Note: If PKI Services Manager is configured to use a non-default port, include the port value using `hostname:port` syntax. For example `acme.com:18081`.

5. Click **Import** and browse to locate the PKI Services Manager public key.
   The key type and fingerprint are displayed after a successful import.
6. Close the open dialog boxes.

**To configure a X Manager for Domains to connect to PKI Services Manager**

1. Start the Administrative Console.
2. Click the **Domain Composition** tab.
3. For **PKI server**, specify the host name or IP address of the computer running PKI Services Manager. (You can specify *localhost* if you're the Reflection X domain controller and PKI Services Manager on the same computer.)

   Note: If PKI Services Manager is configured to use a non-default port, include the port value using `hostname:port` syntax. For example `acme.com:18081`. 
4 Click **Import Key** and browse to locate the PKI Services Manager public key.

The key type and fingerprint are displayed after a successful import.
Glossary of Terms

A

**Administrative Console**

A management tool for administrators that allows you to configure and manage a Reflection X Advantage domain, add domain nodes, perform load balancing, control user access to a domain, monitor sessions, and publish session, X client, and X server definitions that anyone in the domain can use to create sessions.

B

**bandwidth**

The rate of transmission of data across the network; the maximum amount of information (Kbits/second or Mbits/second) that can be transmitted along a channel.

C

**client connector**

Accepts incoming connection requests from X clients and forwards X protocol requests received from the X client to the protocol router. The client connector also receives X protocol replies, events, and errors from the protocol router and forwards these to the appropriate X client.

**client definition**

Contains configuration information for starting one or more X client applications on a host. In previous versions of Reflection X, a client definition was called a client file (.rxc).

**compressor**

Compresses X protocol messages, sends them across the network, decompresses them, and forwards them.

**controlling X server**

The X server in a session that has control of keyboard and mouse input.
D

**definition**

A set of related settings used to configure some aspect of a session. Definitions are stored locally or in a domain. Major types of definitions include client definitions, server definitions, and session definitions.

**distributed X session**

An X session whose session components are running on more than one computer.

**domain**

A Reflection X domain consists of one or more computers on which X session components are run and load-balanced. The domain also defines a group of users who can run and share X sessions on those computers.

**domain controller**

This term applies to the computer that runs the domain controller software component, and is responsible for:

- Providing a way for domains and their domain nodes to locate each other.
- Giving domains the ability to start or stop session components on various domain nodes.
- Authenticating users before granting access to the domain.

**domain node**

A computer on which Reflection X is installed that an administrator has included in a Reflection X domain.

H

**headless X server**

A special type of X server that has no display. It maintains display contents in memory and serves to keep a session "alive" when no other X servers are connected. It can also provide short-circuiting of certain X protocol requests.
IME (Input Method Editor)
An input method editor is an application that allows you to enter characters and symbols that are not available on your keyboard.

internal authentication
A proprietary authentication system that can be used by Reflection X Advantage to grant users access to domain features. If the domain is configured to use internal authentication, Reflection X maintains an internal database of the user names/passwords that are authorized by the system.

JVM
Java Virtual Machine. A virtual machine that interprets and executes Java bytecode. Because Reflection X Advantage is a Java application, a JVM must exist on every machine that runs Reflection X Advantage.

latency
The time delay between when an action is initiated and when its effect is detectable. In a network, a delay in the reception of data packets can be caused by several factors, such as the transmission medium, and the number of network devices between the sending and receiving points. In general, the greater the physical distance between your workstation and your X client host, the greater the chance of encountering latency.

log file
The Reflection X log file (output.txt) is created in the following locations:

- **Windows**: %USERPROFILE%\<user>\attachmate\rx\logs
- **UNIX**: ~/.attachmate/rx/logs
PKCS

PKCS (Public Key Cryptography Standards) is a set of standards devised and published by RSA laboratories that enable compatibility among public key cryptography implementations. Different PKCS standards identify specifications for particular cryptographic uses. Reflection X uses the following PKCS standards:

- PKCS#5 is used to provide password-based encryption for private keys stored in the Reflection X database.
- PKCS#11 provides support for authentication using hardware devices, such as smart cards or USB tokens.
- PKCS#12 is used for storage and transportation of certificates and associated private keys. Files in this format typically use a *.pfx or *.p12 extension. Reflection for Secure IT supports authentication using certificates and keys stored in this format.

private definition

Configuration settings (for either a server, a client, or a session) that can only be viewed and used by the user who created it. A private definition is read-write for the user who created it.

protocol router

Receives X protocol requests from client connectors and forwards them to all of the X servers in the session. It synchronizes the processing of requests and device events to ensure that all the X servers in the session remain in identical states.

public definition

Configuration settings (for either a server, a client, or a session) that an administrator has made available to users in a domain. A public definition is read-write for the administrator and read-only for all other users.

Reflection X Service

A service (or daemon) that can configure a computer as a domain controller, a domain node that runs sessions, and/or a client connector that enables protocol compression.
server definition

The configuration settings for an X server. You can create a server definition yourself or you can clone an existing one (such as Generic X Server) and use it as a starting point for a new one.

session

Consists of several running components (client connectors, a protocol router, and X server(s)) that were configured from a session definition. A session may or may not have X client applications connected to it. All X server displays associated with a session display the same clients; a session may be shared by several users.

session definition

A combination of session settings, an X server definition and, optionally, one or more client definitions. When a session definition is launched, a session is created.

standalone X session

An X session whose components are running on a single computer, in the same JVM.

suspended X session

A running X session that does not have an X server display currently associated with it. When a user leaves a session, its display state is maintained in memory on a member node within the domain.

Web Start Reflection X

A run-time version of Reflection X that is launched from a Web page.

X Manager

A Reflection X tool that allows you to configure and launch X sessions locally, and permits session sharing. It does not use a Reflection X domain; nor does it allow users to leave and rejoin sessions.
**X Manager for Domains**

An application that connects to a Reflection X domain storing session definitions in a database. X sessions run locally, or on domain nodes, which support fault tolerance and protocol compression. It permits session sharing, and allows users to leave and rejoin sessions.

**X server**

The session component that provides a visual display. The controlling X server also manages input devices, such as keyboard and mouse.

**X server display**

An X server with a visual display or "viewer," as opposed to a headless X server, which has no display.

**X session**

See session (page 105).

**XDMCP**

X Display Manager Control Protocol.

**XDMCP broadcast**

The X server performs a UDP broadcast in order to locate hosts.

**XDMCP direct**

The X server does a reset and then sends a request to the X display manager program running on a specific host. You must enter the host name or IP address in the Host name text box.

**XDMCP indirect**

The X server contacts another computer to perform a UDP broadcast in order to locate XDM hosts.
**XIM server**

XIM (X Input Method) is an X11 protocol that supports composed character input. The XIM server provided by Reflection X can obtain composed text from an IME running on the Reflection X workstation and pass this text to XIM-aware X clients. (Reflection X does not support passing composed text to other input methods that may be provided by your operating system, such as XIMP and SCIM.)
Index

A
Active Directory • 87
assign and publish • 87
adding
domain nodes • 64
user accounts • 68
Administrative Console • 55
administrative installation
Advanced tab (installer) • 16
create an installation image • 75
Advanced tab (installer) • 16
Attachmate Customization Tool
creating and editing transforms • 78
how to open • 76
select a customization type • 78
authentication
about domain access • 66
configure and test • 44
configuring Internal • 67
configuring LDAP • 66

B
bandwidth
defined • 101

C
chain installations • 80
client
getting started • 26
companion installer
add files • 85
connecting
configure a Secure Shell connection • 26
getting connected • 25
customize the installation
add files to an installation • 85
Attachmate Customization Tool • 76
creating and editing transforms • 78
select features • 81

D
deployment
Active Directory • 87
deploy with Java Webstart • 70
silent installation • 86
domain nodes • 64
configure domain nodes • 64
domains
about • 55
authentication • 65
best practices • 62
components • 55
domain access • 66
generating started • 31
unlocking • 69

F
Feature Selection tab • 15

I
icons • 49
IME (Input Method Editor)
defined • 103
installation
deploy to Windows workstations • 73
deploy with Java Webstart • 70
feature selection • 14
how to install • 12
planning a domain • 55
requirements • 11
silent installation • 86
upgrade and migration • 17
installation, customizing
add files to an installation • 85
Attachmate Customization Tool • 76
creating and editing transforms • 78
select features • 81
Internal Authentication
configuring Internal • 67
L
latency
  defined • 103
  improve performance in high-latency networks • 31
LDAP authentication
  configuring LDAP • 66
log on to a domain
  unlock domain • 69
M
migrating to Reflection X Advantage
  migrating settings • 17
  upgrade and migration • 17
O
Operating systems, supported • 11
P
password, lost • 69
Performance
  improve performance in high-latency networks • 31
PKI Services Manager
  about • 89
  configure Reflection X to use • 98
  install on UNIX • 94
  install on Windows • 90
  set up on UNIX • 94
  set up on Windows • 90
R
recovery script • 69
Reflection X Service
  features • 55
  installing • 14
    planning a domain • 55
removing Reflection X • 23
requirements • 11
S
Secure Shell
  configure a Secure Shell connection • 26
Sessions
  about session definitions • 51
shortcuts
  to a custom installation • 82
silent installation • 86
SMS • 87
Systems Management Server • 87
T
transforms
  chain installations • 80
  configure shortcuts • 82
  creating • 79
  select features • 81
U
uninstalling • 23
unlock domain • 69
upgrade and migration • 17
user
  adding • 68
  user accounts • 68
    adding • 68
W
Web Start • 70
  deploy with Java Webstart • 70
X
X Manager
  interface • 47
XDMCP
  getting started • 25
XIM server
  defined • 107